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1 Getting Started

Caution

This guide does not replace the daily operations handbook that we recommend customers to create for their
specific production operations.

About this Guide

Designing, implementing, and running your SAP applications at peak performance 24 hours a day has never been
more vital for your business success than now.

This guide provides a starting point for managing your SAP applications and maintaining and running them
optimally. It contains specific information for various tasks and lists the tools that you can use to implement them.
This guide also provides references to the documentation required for these tasks, so you will sometimes also
need other guides such as the Installation Guide, Security Guide, and SAP Library.

Global Definitions

SAP Application

A SAP application is an SAP software solution that serves a specific business area like ERP, CRM, PLM, SRM, and
SCM.

Business Scenario

From a microeconomic perspective, a business scenario is a cycle, which consists of several different
interconnected logical processes in time. Typically, a business scenario includes several company departments
and involves with other business partners. From a technical point of view, a business scenario needs at least one
SAP application (SAP ERP, SAP SCM, or others) for each cycle and possibly other third-party systems. A business
scenario is a unit which can be implemented separately and reflects the customer's prospective course of
business.

Component

A component is the smallest individual unit considered within the Solution Development Lifecycle; components
are separately produced, delivered, installed and maintained.

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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Important SAP Notes

/. Caution

Check regularly for updates available for the Application Operations Guide.

Table 1:
SAP Note Number Comment
1719282 ¥ POS TLOG Table Partitioning Informa- Note describing partitioning of the /
tion POSDW/TLOGF table.

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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2 Technical System Landscape

The following diagram provides an overview of SAP Customer Activity Repository, illustrating the different
components of the repository, optional data replication, as well as the integration with consuming and receiving
applications.
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Figure 1: SAP Customer Activity Repository

Related Documentation

The following table lists where you can find more information about the technical system landscape.
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Table 2:

Guide/Tool

Quick Link on the SAP Service Market-

place (service.sap.com)

Topics

Common Master Guide

http://service.sap.com/instguides#r
|+ industry Solutions ¥ Industry Solution
Guides  SAP for Retail » SAP

Customer Activity Repository @ SAP
Customer Activity Repository <your

release> > Master Guide }

e Application- and industry-specific
components such as SAP Financials
and SAP Retail

e Technology components such as
SAP Web Application Server

e Technical configuration
e Scalability
e High availability

Common Installation Guide

http://service.sap.com/instguides
|} Industry Solutions > Industry Solution
Guides ¥ SAP for Retail  SAP

Customer Activity Repository % SAP
Customer Activity Repository <your

release> > Installation Guide }

e Overall system planning

e System landscape variants

Quick Sizer Tool http://service.sap.com/sizing# Sizing
| Sizing Guidelines ¥ Industries ¥ SAP
Customer Activity Repository, Retail
Application Bundle }

Security Guide http://service.sap.com/security® Security

| SAP Security Guides # Industry
Solutions ¥ SAP for Retail % SAP

Customer Activity Repository & Security
Guide - SAP Customer Activity

Repository <your release> }
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3 Monitoring of SAP Customer Activity
Repository

3.1 Introduction

Within the management of SAP Technology, monitoring is an essential task. A section has therefore been devoted
solely to this subject.

You can find more information about the underlying technology in the SAP NetWeaver Administrator's Guide -
Technical Operations Manual in the SAP Library under SAP NetWeaver Library.

3.2 Alert Monitoring

Proactive, automated monitoring is the basis for ensuring reliable operations for your SAP system environment.
SAP provides you with the infrastructure and recommendations needed to set up your alert monitoring to
recognize critical situations for SAP Customer Activity Repository as quickly as possible.

Component-Specific Monitoring

1 Note
Component-specific monitoring via CCMS is not supported for software components RTL.CAR 200 and
RTLPOSDM 300. Alternative monitoring possibilities are described below.
The Demand Data Foundation (DDF) and Unified Demand Forecast (UDF) modules provide the SAP DMF monitor
set for Computing Center Management System (CCMS) monitoring.

The SAP DMF monitor set displays the monitoring hierarchy of the following UDF services (transaction Rz20):

Table 3: Services and Processes for CCMS Monitoring

Services Monitoring Tree Elements (MTEs, nodes)

Model by hierarchy DMF MODEL PROCESSES BY HIER
Model by product location DMF_MODEL PROCESSES_BY PROD_LOC
Forecast by hierarchy DMF_FORECAST PROCESSES BY HIER

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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Services ‘ Monitoring Tree Elements (MTEs, nodes)
Forecast by product location DMF FORECAST PROCESSES BY PROD LOC
Calculate hierarchical priors DMF CALCULATE HIER PRIORS

1 Note

A node may display the MTE class: No MTEs currently available message. This message indicates that the
associated UDF service has not yet been run on this system to generate the Monitoring Tree Elements for this
node.

Monitoring of SAP HANA

You can monitor SAP HANA through SAP HANA studio or SAP Solution Manager.
SAP HANA Studio

The System Monitor in SAP HANA studio provides an overview of SAP HANA systems with information such as
the operational state, alerts generated, disk size for data, log and trace, memory used, percentage of CPU being
used, and so on. For more detailed monitoring of resource usage and performance for a particular SAP HANA
system, please use the Administrator Editor.

For information about the installation and general monitoring and administration of SAP HANA, and about the use
of SAP Solution Manager with SAP HANA studio, see SAP Help Portal for SAP HANA Live at http://

help.sap.com/hball Installation, Security, Configuration, and Operations Information # Administrator's Guide .

For more information about monitoring SAP HANA systems using SAP HANA studio, see SAP Help Portal for SAP
HANA Platform at http://help.sap.com/hana_appliancelr System Administration » SAP HANA Administration
Guide 3.

SAP Solution Manager

SAP Solution Manager can also be used for basic administration and monitoring of SAP HANA systems within
SAP landscapes. SAP HANA integrates into existing operations with little effort if SAP Solution Manager is already
in use. It is highly recommended to use SAP Solution Manager Release 7.1 SPO5 or higher in order to get optimal
support for SAP HANA. The monitoring and alerting infrastructure of SAP Solution Manager is based on central
agent infrastructure. Pre-configured agents for SAP HANA are delivered by SAP. Once the agents are deployed on
SAP HANA and connected to SAP Solution Manager, SAP Solution Manager will receive all alerts of the HANA
studio. For larger and more complex landscape scenarios, SAP Landscape and Virtualization Manager (LVM)
integrates with SAP HANA to allow basic operations like starting and stopping as well as management of
dependencies.

For more information about connecting SAP Solution Manager to SAP HANA, see the SAP HANA Technical
Operations Manual on SAP Help Portal for SAP HANA Appliance Software at http://help.sap.com/hana_appliance
|» System Administration » SAP HANA Technical Operations Manual 3. See also SAP Service Marketplace at
http://support.sap.com/solutionmanager .

For more information about SAP Solution Manager, see SAP Help Portal for Solution Manager at https://
help.sap.com/solutionmanager.

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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Monitoring of SAP Customer Activity Repository

Monitoring for the POS Data Management component in SAP Customer Activity Repository consists of the
following:

e POS DM Application Log

e POS DM Message Log

e Auditor Report

® Trace and Log files (accessed using transaction SLG1 to log and trance ABAP components)

Monitoring of the SAP Landscape Transformation Replication Server

If you are replicating data from other source systems, monitoring of the SAP Landscape Transformation (LT)
Replication Server is essential to ensure data consistency between the source system (for example, SAP ERP)
and SAP Customer Activity Repository. The Configuration and Monitoring Dashboard (transaction LTR inthe SLT
server) provides users with information that can be used to monitor and identify potential replication issues. The
overview screen provides the overall status of the configurations. For each configuration, detailed information is
provided, which includes statuses of jobs and connections, statuses of database triggers for tables selected for
replication, and statistical information about tables and settings.

As of release DMIS_2010 SPO7 on the SAP LT Replication Server, you can use system monitoring capabilities of
SAP Solution Manager 7.1 (SPO5 or higher) to monitor the status of a configuration and its related schema.

For more information about monitoring load and replication process, see SAP Help Portal at http://
help.sap.com/hanallr SAP HANA Options » SAP HANA Real-Time Replication » SAP HANA Trigger-Based Data
Replication Using SAP LT Replication Server » System Administration and Maintenance Information

Configuration Information and Replication Concepts » Monitoring of Load and Replication Process 4.

3.3 Detailed Monitoring and Tools for Problem and
Performance Analysis

Use

The following functions are available within SAP Customer Activity Repository to monitor data flow within the
application:

® /POSDW/LOGS - POS Data Management Application Log

® /POSDW/DISPLAY MESSAGELOG - POS Data Management Message Log

® /POSDW/DISPLAY MODIFICATIONS - Auditor Report

POS Data Management Application Log

The POS Data Management Application Log collects messages, exceptions, and errors, and displays them in a log.
This log provides you with basic header information, a message long text, detailed information, and technical

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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information. For more information, see SAP Help Portal for SAP NetWeaver at http://help.sap.com/nw. Choose a

release. Under Application Help, choose | Function-Oriented View » SAP NetWeaver Library: Function-Oriented

View # Application Server ¥ Application Server ABAP » Other Services ¥ Services for Business Users
Application Log - User Guidelines (BC-SRV-BAL) 1.

POS Data Management Message Log

The POS Data Management Message Log displays message logs by store and by posting date. You can filter the

report by message-related criteria, such as message class or message priority.

Auditor Report

You use the Auditor Report to track manual changes made to POS transactions, as well as to get information
about the origin of the transactions, such as the POS Workbench, an IDoc, or a remote function call module.

Trace and Log Files

Trace files and log files are essential for analyzing problems. Transaction SLG1 is used to log and trace ABAP

components. An Application Log consists of a log header and a set of messages. The log header contains general

data, such as type, created by/on, and so on. Each log in the database also includes the attributes Object and
Subobject. These attributes are used to describe and classify the application that has written the log.

Table 4: Important Log and Trace Files of POS Data Management (RTLPOSDM) Component

Object Subobject Description

/POSDW/PIPE CHANGE TASKSTATUS Task status change

/POSDW/PIPE CREATETREX TREX index generation

/POSDW/PIPE CREDITCARD MIGRATION Migration of encryption of credit card
numbers

/POSDW/PIPE DELETE Delete program

/POSDW/PIPE DELETE AGGREGATE Deletion program for POS aggregates

/POSDW/PIPE IDOCDISPATCHER IDoc dispatcher

/POSDW/PIPE INBOUND DISPATCHER Initial processing using queue

/POSDW/PIPE OUTBOUND DISPATCHER Outbound processing for POS aggre-
gates

/POSDW/PIPE PIPEDISPATCHER POS dispatcher

/POSDW/PIPE REFRESH INDEX Reconstruction of transaction index

/POSDW/PIPE REORG_TIBQ Reorganization of TIBQ

/POSDW/PIPE STOREDAYCHANGE POS Data Key change

/POSDW/PIPE XML IN Import POS Transactions as XML file

/POSDW/PIPE XML OUT Export POS Transactions as XML file

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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Table 5: Important Log and Trace Files of SAP Customer Activity Repository (RTLCAR) Component

Subobject Description
/POSDW/PIPE OSADISPATCHER Status of the execution of the On-Shelf
Availability Parallel Processing of Alerts
report.

For more information, see the SAP Help Portal for SAP NetWeaver at http://help.sap.com/nw. Choose a release.
Under Application Help, choose | Function-Oriented View » SAP NetWeaver Library: Function-Oriented View
Application Server ABAP  Other Services ¥ Services for Business Users # Application Log - User Guidelines (BC-
SRV-BAL) 1.

Archiving
Archiving of Data Used by SAP Customer Activity Repository

If you replicate data from other source systems to SAP Customer Activity Repository using SLT replication, the
replicated data follows the data lifecycle of the source system. As such, when data is archived on the source
system, it is deleted from the repository. Similarly, if you access data of other source systems directly from the
repository (possible when the repository is co-deployed with the source system on the same SAP HANA
database), you do not have access to archived data.

For example, if you archive sales documents in SAP ERP (for example, for performance reasons), these sales
documents will no longer be available in SAP Customer Activity Repository. This could affect your reports if you
choose to have a short lifecycle of sales documents in SAP ERP. For example, if you archive sales documents after
nine months, a year-to-date multichannel sales analysis report in December would miss the sales documents data
for most of the first quarter.

For more information on deployment options for SAP Customer Activity Repository, see http://help.sap.com/car
|» <your release> ¥ Installation and Upgrade Information  Installation Guide 7.

Data Growth and Data Archiving Monitors

The following are the fastest growing tables in SAP Customer Activity Repository:

Table 6:
Technical Name of Table Description
/POSDW/TLOGF Transaction Log Flat table
/POSDW/TLOGF_EXT Transaction Log Extensions table
/POSDW/TLOGEF X Transaction Log Optimized Extensions table
/POSDW/TIBQ Inbound Queue for POS Transactions
/POSDW/TIBQ ADM Management Records of Inbound Queue for POS Transac-
tions
/POSDW/SOBJL Source Object Link for POS Transactions
/POSDW/PLOG1S Processing Log for Small Logs

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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Technical Name of Table Description

/POSDW/TSTAT Areas of Task Status
/POSDW/NAVIX Navigation Index for Store and Day
/POSDW/AGGR POS Aggregate

You can use the SAP HANA Studio to identify which tables use the most disk space. To verify the amount of disk
space used by a table, do the following:

1. Logonto SAP HANA Studio.
Locate the name of your system in the Navigator pane.

w N

Right-click on your system name and select Administration from the context menu.

»

Select the System Information tab.

o1

Select the Size of tables on disk entry.
The tables are displayed with their corresponding disk usage values.

SAP Customer Activity Repository uses the standard archiving and monitoring data archiving tools available in
SAP NetWeaver. It does not require any application-specific tools. There are two relevant archiving objects: /
POSDW/AGG and /POSDW/TLF.

The following SAP Notes relate to data growth and archiving in SAP Customer Activity Repository:

e 313537# (General notes about archiving POS data)
e 625081 (Archiving objects and namespace)

For more information about the standard archiving tools, see the SAP Help Portal for SAP NetWeaver at http://
help.sap.com/. Choose a release. Under Application Help, choose | Function-Oriented View » SAP NetWeaver
Library: Function-Oriented View » Solution Lifecycle Management » Data Archiving ¥ Data Archiving in the ABAP
Application System ¥ Data Archiving with Archive Development Kit (ADK) ¥ Archive Administration 3.

Data Load After a Reboot

When you reboot an SAP NetWeaver powered by SAP HANA system, all data that was stored in-memory is lost,
and must be reloaded from the permanent persistency layer of the SAP HANA database. After the reboot, the first
time you run the SAP Customer Activity Repository application, you may experience significant delays as the
application reloads tables such as /PoSDW/TLOGF or /POSDW/NAVIX for the first time.

To avoid these delays, it is recommended that you reload all POS Data Management tables with high disk space
usage in the following instances:

e |mmediately following the reboot of your SAP NetWeaver powered by SAP HANA system
® Prior to launching the SAP Customer Activity Repository application.

First, you must identify which tables use the most memory. See the Data Growth and Data Archiving Monitors
section above.

Then, for each table, run the following SQL command to load the table from the permanent persistency layer into
main memory:

load <SAP SCHEMA>."<TABLE NAME>" all

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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where <SAP SCHEMA> is the name of your SAP HANA database schema and <TABLE NAME> is the name of the
table to load. You can verify the database schema of a particular table in SAP HANA Studio using the same
process you use to verify table disk space usage.

You can also create an SQL script that will be automatically executed following an SAP NetWeaver powered by
SAP HANA system reboot. You can use the SAP HANA Studio SQL Editor to create this script, or, you can create
an ABAP report which will include the following commands:

all.

EXEC SQL.

load <SAP SCHEMA>."<TABLE NAMEI1>"
load <SAP SCHEMA>."<TABLE NAME2>" all.
load <SAP_ SCHEMA>."<TABLE NAME3>" all.
ENDEXEC.

More Information

For detailed monitoring information about the underlying components of SAP Customer Activity Repository, see

the following:
Table 7:

Reference

Important Sections or Topics (If Appli-

cable)

Technical Operations for SAP NetWea-
ver

See SAP Help Portal for SAP NetWeaver
at http://help.sap.com/nwl} <your
release> > System Administration and
Maintenance Information > Technical

Operations for SAP NetWeaver #
Administration of Application Server

ABAP > Monitoring and Administration
Tools for Application Server ABAP }

e Statistics, Displaying and Control-
ling Work Processes ( SM50)

e SystemLog(sM21)
e ABAP Dump Analysis

SLT System Administration and Mainte-
nance Information

See SAP Help Portal for SAP HANA at
http://help.sap.com/hana|: SAP HANA
Options # SAP HANA Real-Time

Replication > SAP HANA Trigger-Based
Data Replication Using SAP LT

Replication Server # System
Administration and Maintenance

Information 1

Changing Load and Replication Proce-
dures

14 CUSTOMER
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Reference Important Sections or Topics (If Appli-

cable)

SAP HANA Administration Guide See SAP Help Portal for SAP HANA Ap- | Monitoring SAP HANA Systems
pliance Software at http://
help.sap.com/hana_appliance

|} System Administration > SAP HANA
Administration Guide }

3.4 Detailed Monitoring and Analysis Tools Specific to On-
Shelf Availability

The following function is available to monitor the OSA-specific data flow within the application:

® /POSDW/L0GS: SAP POS DM Application Log
The SAP POS DM Application Log collects messages, exceptions and errors, and displays them in a log. This
log provides you with basic header information, a message long text, detailed information, and technical
information.

For more information, see the SAP Library Help at http://help.sap.com/nw74/| Application Help » Function-
Oriented View ¥ Application Server ¥ Application Server ABAP  Other Services # Services for Business Users
» Application Log - User Guidelines (BC-SRV-BAL) 1.

Trace and Log Files

Trace files and log files are essential for analyzing problems. The S1.G1 transaction is used to log and trace ABAP
components. An application log consists of a log header and a set of messages. The log header contains general
data, such as type or created by/on data. Each log in the database also includes the attributes Object and Sub-
Object. These attributes are used to describe and classify the application that wrote the log.

Table &:
Sub-Object Description
/POSDW/PIPE OSADISPATCHER Status of the execution of the On-Shelf
Availability Parallel Processing of Alerts
report.

For more information, see the SAP Library Help at http://help.sap.com/nw74/|F Application Help ¥ Function-
Oriented View ¥ Application Server » Application Server ABAP » Other Services # Services for Business Users »
Application Log - User Guidelines (BC-SRV-BAL) 1.

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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Cleanup of growing data

OSA computation data is historized, that is stored with the execution date and time and used in the analysis step
of On-Shelf Availability processing. Because of growing data amounts, SAP recommends to perform a clean-up in
regular intervals. The transaction /0sA/CLEANUP deletes OSA computation data from the SAP HANA Database.

Inthe /0SA/CLEANUP transaction, you can specify the following parameters:

e The range of stores for which you want to perform the cleanup

® The date range for which you want to perform the cleanup

e Testmode:
o If test mode is activated, selected data will be only listed but not deleted
o If test mode is deactivated, selected data will be deleted

e Detail level of the messages that will be logged during the cleanup

/0SA/CLEANUP deletes OSA computation data together with run information from the following OSA tables:

® /osa/mon_ana

® /osa/mon_ana sum
® /osa/ana_conf

® /osa/estimat

® /osa/est conf

® /osa/iw_pattern
® /osa/iwp conf

® /osa/monitoring
® /osa/mon_sum

® /osa/mon conf

The user who executes cleanup needs read and write privileges for the tables that are deleted during cleanup.

Data Growth and Archiving the Monitor Results

The /0sSA/STATUSLOG table is the fastest growing OSA table.
Use the sARA transaction to archive the /0SA/STATUSLOG table in regular intervals.

The On-Shelf Availability functionality uses the standard archiving and monitoring data archiving tools available in
SAP NetWeaver. It does not require any application-specific tools. The relevant archiving object is /0SA/STATU.

For more information regarding the standard archiving tools, see the SAP Library Help at |+ http://help.sap.com/
nw74/ ¥ Application Help ¥ Function-Oriented View » Solution Lifecycle Management » Data Archiving » Data
Archiving in the ABAP Application System  Data Archiving with Archive Development Kit (ADK) ¥ Archive
Administration 3.

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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3.5 Data Consistency

SLT Replication

Data can be optionally replicated from SAP ERP and from SAP CRM to SAP Customer Activity Repository. If you
replicate data, the information in the replicated tables must be consistent between the source and the target
systems.

Caution

You can monitor the processes of the SAP Landscape Transformation (SLT) Replication server using the
Configuration and Monitoring Dashboard, as specified in the Alert Monitoring [page 8] section. However, the
dashboard does not currently provide an automated way to monitor the consistency of replicated tables. When
performing SLT replication, you must verify that all the tables required for your SAP Customer Activity
Repository implementation, as well as their contents, are being replicated.

More general information about deployment options and data replication into SAP Customer Activity Repository
is described under http://help.sap.com/car| <your release> ¥ Installation and Upgrade Information »
Installation Guide 3.

Master Data Checking

The system automatically executes the master data checks that you created in the Customizing for POS Inbound
Processing.

The master data checks are processed in the following situations:

e During the inbound processing of POS transactions
e \When the editor is started for a particular POS transaction within the POS Workbench
e \When tasks are processed

The system checks for POS transaction data and automatically enhances it with further data. If there is no valid
master data in the system, the master data check fails and a corresponding error message is displayed. There is
no further processing of the affected POS transaction within the task processing.

If all checks and data enhancements are successful, the system continues executing the functions, without
interruption, according to the guidelines prescribed by which checks were already performed.

You can also check transaction data when executing processing tasks using rules that you have created in

Customizing (transaction SPRO) under | POS Inbound Processing » Tasks » Define Rules 3. Once you have
created arule, you can execute a specific activity depending on the result you receive. You create rules when you
want to process tasks only if certain conditions are met.

SAP Customer Activity Repository 2.0 SP4 Operations Guide
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ABAP Shared Memory Objects

The POS Data Management component of SAP Customer Activity Repository includes functionality to verify
master data in the transactions received from the point-of-sale.

Retrieving master data from database tables through SAP HANA views to perform master data checks for
Material, Unit of Measure, and International Article Number (EAN) can result in slower system performance,
especially in situations when the number of master data records is high. To improve system performance, the
implementation of the master data retrieval uses ABAP shared memory objects to buffer the contents of the
master data tables in a shared memory area of the SAP NetWeaver application server. After the initial load of the
shared memory objects, instead of going to the database to retrieve the required data, the data is retrieved from
the shared memory objects, thereby providing faster data retrieval.

Each version of a shared memory object becomes obsolete 60 minutes after a change lock is released, and the
application server performs an automatic refresh from the database.

Shared Objects Area Management (transaction SHMA) is used to display areas for shared objects and their
properties.

Shared Objects Monitor (transaction sHMM) provides an overview of the area instances in the shared objects
memory of the current application server, and offers selected functions for it.

The following area instances in the shared object memory are relevant for SAP Customer Activity Repository:

Table 9:
Shared Memory Object Area Description
® /POSDW/CL_MATERIAL BUFFER_AREA The POS Data Management component of SAP Customer Ac-
® /POSDW/CL MARM BUFFER AREA tivity Repository includes functionality to verify master data in
® /POSDW/CL_MEAN BUFFER AREA the transactions received from the point-of-sale. Master data

checks for Material, Unit of Measure, and International Article
Number (EAN) retrieve master data from database tables
through SAP HANA views. The listed shared memory object
allow faster access to this data.

¢ /POSDW/CL_POSCTRL_BUFFER_AREA Implementation /POSDW/ANALYTIC DIST ENH IMP of BAd!:
POS Transaction Data Distribution to Item Level distributes
discount amounts from the transaction header to the transac-
tion line items. This BAdI implementation uses the listed
shared memory object to speed up access to SAP HANA view
sap.is.retail.ecc.ARTICLEPOSCTRL, which containsin-
formation on whether an article is discountable or not.

Additional general information about ABAP shared memory objects can be found in the SAP NetWeaver
application help at <_sfe:ExternalLink xmins:_sfe="http://www.arbortext.com/namespace/Styler/
StylerFormattingElements" href="http://help.sap.com/saphelp_nw70/helpdata/en/df/
109b8b4b073b4c82da0f2296c3a974/frameset.ntm">http://help.sap.com/saphelp_nw70/helpdata/en/df/
109b8b4b073b4c82da0f2296c3a974/frameset.ntm</_sfe:ExternalLink>

Shared Memory Object Size
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Every retail business is different, and as such, the amount of master data, such as the number of articles, or unit
of measure definitions, is also different. The amount of memory required to buffer this master data at the
application server level varies from business to business.

To set the size of shared memory, do the following:

1
2.

3.

Execute transaction Rz11 in your SAP Customer Activity Repository system.
Enter abap/shared_objects_size_ MB as the parameter name and choose Display.

In the Maintain Profile Parameters screen, choose Change Value or |» Edit » Change Value 3 (depending on
your SAP NetWeaver version).

Enter the appropriate shared memory size, in MB, in the Current Value field.

We recommend setting the shared memory size to at least 300 MB. Out of this 300 MB, 10-20% is reserved
for the internal administration of shared memory.

For more information on troubleshooting shared memory sizing issues, see the following subsection as well as
SAP Note 1322182 .

Restart the application server.

Changes to shared memory size only take affect once the application server is restarted.

Troubleshooting Shared Memory Object Issues

Runtime errors that are related to the use of shared memory objects that can occur are as follows:

Shared Memory Object Sizing Issues

Typically, a runtime error caused by a Cx SHM OUT OF MEMORY exception, indicates that an insufficient
amount of memory is allocated to shared memory.

If your SAP Customer Activity Repository application is terminated as a result of a cCx_SHM OUT OF MEMORY
exception, verify the Runtime Error Long Text provided with the runtime error (this can also be accessed using
transaction sT22). The long text provides the size of the objects that the application was attempting to load
into one of the /POSDW/CL_* BUFFER AREA shared memory objects. You should increase the size of shared
memory, as described in the previous subsection, by at least this amount, plus an additional 10-20% buffer
required for administrative activities.

For example, abap/shared objects size MBis currently setto 300 MB. Your SAP Customer Activity
Repository application produces a runtime error, indicating that 500 MB of fails to load into the /pPosDW/

CL MATERIAL BUFFER AREA. You should increase the size of abap/shared objects size MBfrom 300
MB to 850-900 MB and restart the system.

Shared Memory Area Initialization Delays

When SAP Customer Activity Repository performs master data checks to verify material, unit of measure, and
International Article Number (EAN) data, the system verifies the data included in the received POS
transactions against the data buffered in the shared memory objects ( /poSDwW/

CL MATERIAL BUFFER AREA, /POSDW/CL MARM BUFFER AREA, /POSDW/CL MEAN BUFFER ARER).Ifthe
master data check occurs prior to the initialization of the shared memory area, this can result in a runtime
error caused by a CXx_SHM NO ACTIVE VERSION exception.

The time required to initialize the shared memory area (that is, the time required to load master data from the
database tables into the dedicated shared memory objects) is controlled by the

SHM MAXIMUM PRELOAD WAIT TIME componentofthe SETTINGS parameter used by the CALL method of
BAd| /POSDW/SETTINGS. By default, SHM MAXIMUM PRELOAD WAIT TIME is setto 10 seconds. If youare
experiencing runtime errors caused by a CX SHM NO_ ACTIVE VERSION exception, you may need to increase
the value of SHM MAXIMUM PRELOAD WAIT TIME to allow for alonger period to initialize the shared memory
area.

For more information, see SAP Note 1965920 #& .
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Staging Tables

External data providers write data into the staging tables. During a Remote Function Call (RFC), the data providers
can additionally provide a high resolution time stamp.

Every data record in the staging tables has a high resolution time stamp (field EXT KEY TST). The time stamp is
part of the data record key. As a result, different records for the same object can exist in the table at any given
point in time. When processing the data from the staging tables, the newest data record of each object is used.

Authorization Checks

The system performs authorization checks on the following function groups:

® /DMF/BI SALES INBOUND (/nbound RFC for Bl Sales Data)

® /DMF/MDIF IMAGE DATA ( DMF Inbound RFC Image Data)

® /DMF/MDIF LANE ( DMF Inbound RFC Lane Data)

® /DMF/MDIF LOCATION ( DMF Inbound RFC Location)

® /DMF/MDIF LOC HIER (DMF Inbound RFC Location Hierarchy)

® /DMF/MDIF_ PRODUCT ( DMF Inbound RFC Product)

® /DMF/MDIF PROD HIER (DMF Inbound RFC Product Hierarchy)

® /DMF/MDIF PROD LOC ( DMF Inbound RFC Product Location)

® /DMF/OPIF INVENTORY (/nbound Staging Modules for Inventory)
® /DMF/TS GENERIC INBOUND (/nbound RFC for Generic Time Series)
® /DMF/DISTRIBUTION CURVE (Distribution Curve Function Group)

Data Validation for Modeling and Forecasting

You can run a data validation report prior to performing demand modeling and forecasting. This allows you to
identify potential issues in your input data early on and rectify them as needed. For more information about this
report, see SAP Note 2161484

3.6 Detailed Monitoring and Analysis Tools Specific to
Demand Data Foundation

3.6.1 Preparing Exception Handling

The Demand Data Foundation (DDF) module in SAP Customer Activity Repository uses the exception handling
framework to log errors that have occurred during background processes.
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The exception definition is based on the general ABAP message concept. Each exception is identified by the
combination of a message class and a message number. Each instance of an exception has a unique internal ID
(message handle).

For more information about the exception handling framework, see SAP Help Portal at http://help.sap.com/car

|» <your release> » Application Help » Demand Data Foundation » General Services » Exception Management 4.

1 Note

There are subobjects that do not use the exception handling framework. For a list of those objects and more
information on how you can monitor them, see Analyze Application Log [page 23].

3.6.2 Configuring Exceptions

Before actual exception instances can be created, you must first configure the exceptions in Customizing
(transaction SPRO). To do this, you use the activities under [+ Cross-Application Components ¥ Demand Data
Foundation ¥ Basic Settings » Exception Management 3.

For more information, see the following:

e System documentation of each activity

e Section Customizing under http://help.sap.com/car|p <your release> » Application Help » Demand Data
Foundation » General Services ¥ Exception Management J

High Level Exceptions

You can configure high level exceptions under |+ Cross-Application Components  Demand Data Foundation
Basic Settings » Exception Management  Maintain Configuration Data for High Level Exceptions 3.

You can do the following:

® Assign business areas to exceptions (such as Forecasting)

® Assign priorities to exceptions (such as Medium Priority)

e Define message types (such as Error, Warning, Information)

e Define validity periods after which the exceptions can be purged from the database

Low Level Exceptions

Additionally, you can assign a priority to each low level exception under | Cross-Application Components »
Demand Data Foundation } Basic Settings » Exception Management » Maintain Configuration Data for Low Level

Exceptions 1.
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Customer-Specific Replacement Messages

You can define your own message texts under [+ Cross-Application Components » Demand Data Foundation ¥

Basic Settings  Exception Management j Define Customer-Specific Replacement Messages 3.

Customizable Message Statuses

In addition to the defaults provided ( New, Processed, Ignore), you can define your own message statuses under
| Cross-Application Components » Demand Data Foundation # Basic Settings ¥ Exception Management ¥ Define
Customizable Message Status .

3.6.3 Monitoring Exceptions

Use

Exceptions are system-based messages that inform users about situations requiring special attention or action.
You can use the Monitor Exceptions service to review and process the exceptions.

You can do the following:

e Getan overview of the number of exceptions

® Filter the exceptions based on a number of different criteria

e Perform additional filtering based on the business area, context type, or context instance (value)
® Display the selected exceptions in a table

e Display the detailed information on the exception

e Display all low level exceptions assigned to a selected high level exception

More Information

e To access this service from your SAP Easy Access screen, execute transaction nwbe and choose ||# Services »
Monitor Exceptions 3.

e For more information about how to use this service, see SAP Help Portal at http://help.sap.com/carllr <your
release> » Application Help » SAP Customer Activity Repository # Demand Data Foundation » General
Services ¥ Exception Management » Monitor Exceptions 3.
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3.6.4 Purging Obsolete Exceptions

Depending on your scenario, you might have large numbers of exceptions occurring during system operation. We
recommend that you regularly purge (delete) the obsolete exceptions from the database. To do this, you can use

the Purging Exceptions from the Database report ( /DMF/PURGE_EWB MESSAGES). For more information, see SAP
Help Portal at http://help.sap.com/carl <your release> ¥ Application Help » Demand Data Foundation ¥

General Services » Exception Management » Monitor Exceptions 3.

3.6.5 Analyzing Application Logs

You can use application logs to record application-specific events. The logs record the execution progress of the
application so that you can reconstruct it later if necessary.

The Analyze Application Log function allows you to filter the collected information (such as messages, exceptions,
and errors) for the information that you need. The following information is available:

® Basic header information on the events that have occurred

e Fvent details

e Technical information

® Message short and long texts

Procedure

You use the Analyze Application Log function as follows:

1. Call up the function via transaction SLG1.
2. Inthe Object field, specify the object whose application log you want to view. For example, specify /DMF/APPL
for the Demand Data Foundation (DDF) module in SAP Customer Activity Repository.

3. Inthe Subobject field, limit your search to specific DDF subobjects if desired:

© /DMF/AFNTY

© /DMF/ATR

o0 /DMF/ENGINE

© /DMF/MERCH PLAN

© /DMF/OFFER

© /DMF/OFFER PURGE

O /DMF/PHP

4. Specify additional criteria as needed and execute the function.

1 Note

You can define entries for your own applications in the application log via transaction SLGO0. Use this
transaction with care, as the associated table is cross-client.
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3.6.6 Workload Monitoring

Use

Using the Workload Monitor

You can use the workload monitor (transaction ST03) to analyze statistical data for the ABAP kernel. If you are
analyzing the performance of a system, you should normally start with the workload overview. You can also
display the total values for all instances, and compare the performance of particular instances over a period of
time. A wide range of analysis views and data helps you to find the source of performance problems quickly and
easily.

Managing Inbound Processing for Demand Data Foundation

Inbound processing comprises the import of master data and transactional data into the Demand Data
Foundation (DDF) module in SAP Customer Activity Repository. By default, inbound processing takes place as
follows:

1. You send the data from the external system to DDF using a Remote Function Call (RFC) or enterprise
services, for example. You can do either an initial load and or a delta load, which transfers only the changed
object instances.

2. Theimport datais stored in the staging tables in DDF. No business validations are performed at this point.

1 Note

You can choose to skip this step and bypass the staging tables. The imported data is then saved directly in
the production tables. For more information, see Customizing (transaction SPRO) under |[» Cross-
Application Components » Demand Data Foundation » Basic Settings ¥ Integration » Define Import

Settings 3. Here you can define for each type of master data and transactional data whether you want to
bypass the staging tables or not (default setting).

3. Thedatais transferred from the staging tables to the production tables. Business validations are performed.
Once the data is available in the production tables, it can be used for follow-on processes (such as demand
modeling and forecasting with the Unified Demand Forecast module).

Available Services

Different services help you manage the inbound processing:

e Monitor Imports
See http://help.sap.com/car|lp <your release> » Application Help » SAP Customer Activity Repository

Demand Data Foundation » General Services » Monitor Imports 3.
® Process Inbound Staging Tables

See the /DMF/PROCESS STAGING TABLES report and http://help.sap.com/car|lp <your release> »
Application Help » SAP Customer Activity Repository » Demand Data Foundation » General Services »
Monitor Imports » Process Inbound Staging Tables 3.

Additional Options

You can use the following options to adapt the inbound processing to your needs:

e |f the processing of transportation lane, product location, or sales data from the staging tables to the
production tables takes more time than expected, you can use the /DMF/SET STAGING CONFIG TABLE
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report to activate an alternative packaging. For more information, see the report documentation (transaction
SE38) and SAP Note 2019909 .

You can schedule the Process Inbound Staging Tables service as a batch job to move the data from the
staging tables.

You can move the data manually from the staging tables. The | Monitor Imports » Manual Processing 3
option is available for this.

More Information

http://help.sap.com/car|lp <your release> » Application Help » SAP Customer Activity Repository » Demand

Data Foundation ¥ Integration Information 3 and Inbound Processing

3.7 Detailed Monitoring and Analysis Tools Specific to
Omnichannel Article Availability

SAP Customer Activity Repository and SAP Retail

® The parallelized ATP run (report /OAA/ATP CALL_PRECALC) thatis triggered in SAP Customer Activity

Repository and executed in SAP Retail follows standard ABAP job monitoring (transaction SM37) and uses the
standard application log (transaction SLG1)

o Application log object in SAP Customer Activity Repository: /0AA/ATP, no subobjects

o Application log object in SAP Retail: /OAA/ATP _PRECALC, no subobjects
To activate the traceability of the parallelized ATP run, you need to activate user parameter
W_OAA JOB TRACING (transaction su3) in SAP Retail for the technical user entered in the RFC destination in
SAP Customer Activity Repository for the SAP Retail destination. This allows you to trace the result of the
parallelized ATP run during the implementation phase in the job monitor log of SAP Retail (transaction sM37).
In the productive system, activate this user parameter in case of errors only, to improve performance.

SAP Customer Activity
Repository

SAP Retail

returns

Loy og: O Application Log (SLG1)
Messages Log Object:
- Application Log (SLG1)

Log Ohject:

Application Log (SLG1T)
T A Log Object:
Application P .
Log (SLG1) TOAAATP_PRECALC
Job Maonitor
(3M37) Log Object:
TOAAIATR

Job Monitor Job Monitor Job Monitar
(SM3T) (SMI7) [SM3T)
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e With all reports in SAP Customer Activity Repository and SAP Retail, errors are logged with the reports.

® Thereis no application monitoring.

e With REST services in SAP Customer Activity Repository , there is no logging; errors are returned to the caller
(that is, the online store software application). There is no application monitoring for the REST services.

SAP Hybris Commerce

OAA functionality in SAP Hybris Commerce uses standard monitoring and logging for both applications and Data
Hub. The logger package is com.sap.retail.oaa.commerce.services.

3.8 Detailed Monitoring and Analysis Tools Specific to
Omnichannel Promotion Pricing

Monitoring Log Information of Transformations

In transaction SLG1, you can display the log and trace information that is created during the manual
transformation of an offer into an OPP promotion after the offer has been approved. Use the following settings for
object and sub-object:

Table 10:
Sub-Object Description
/ROP/APPL /ROP/BO Omnichannel Promotion Pricing Applica-
tion

For more information, see the Application Help for SAP NetWeaver 7.4. In the Application Help, choose
|# Function-Oriented View j» Application Server » Application Server ABAP » Other Services j» Services for
Business Users ¥ Application Log- User Guidelines (BV-SRV-BAL) 3.
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Monitoring Outbound of Prices and OPP Promotions

The outbound of regular prices and OPP promotions can be monitored with the following two transactions:

Table 11:

Transaction Code

DRFLOG

Transaction Title

Analyze Log for Outbound Im-
plementations

Description

Use this transaction to analyze the Data Replication Frame-
work (DRF) outbound process. You can choose the following
filter criteria:

e The replication model that you have created for the
replication of regular prices and OPP promotions. For
more information, see the Application Help for SAP
Customer Activity Repository. In the Application Help,

and choose | Omnichannel Promotion Pricing

Replicating Regular Prices and OPP Promotions |
® CROP_PRICE as the outbound implementation to moni-

tor the outbound of regular prices.

ROP_PROMO as the outbound implementation to monitor the

outbound of OPP promotions.

IDoc List

Use this transaction, if the content of the sent IDocs is of pri-
mary interest. You can choose the filter settings according
to your Application Link Enabling (ALE) Customizing. For
more information, see the Application Help for SAP Cus-

tomer Activity Repository, and choose |} Omnichannel

Promotion Pricing ¥ Replicating Regular Prices and OPP

Promotions Application Link Enabling 3
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4 Management of SAP Customer Activity
Repository

4.1 Introduction

SAP provides you with an infrastructure to help your technical support consultants and system administrators
effectively manage all SAP components and complete all tasks related to technical administration and operation.

You can find more information about the underlying technology in the Technical Operations Manual in the SAP
Library under SAP NetWeaver.

4.2 Starting and Stopping

Start and Stop Sequences and Tools

Table 12:
Software Component Sequence Tool Detailed Description
SAP HANA Database 1 sapstartsrv See the information about
starting and stopping SAP
HANA systems in the SAP
HANA Administration Guide.
RTLCAR 2 STARTSAP Log on to the host of your

central system as the SAP
Administrator.

Enter startsap ALLto
start the SAP NetWeaver da-
tabase, ABAP instances, and
all other processes.
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Software Component Sequence

Detailed Description

SAP LT Replication Server 3
(Optional)

SAP HANA Studio

Use SAP HANA Studio to
start replication of tables re-
quired by SAP Customer Ac-
tivity Repository.

See http://help.sap.com/car

|» <your release>
Installation and Upgrade

Information > Installation

Guide 1 for information on
deployment options, which
determine whether replication
is necessary. If replication is
required, this guide also pro-
vides information on how to
set up table replication and
which tables need to be repli-
cated.

For more information, see
SAP Help Portal at http://

help.sap.com/hanallr SAP
HANA Options # SAP HANA

Real-Time Replication » SAP
HANA Trigger-Based Data
Replication Using SAP LT

Replication Server » System
Administration and

Maintenance Information }

SAP LT Replication Service 4
(Optional)

SAP HANA Studio

Use SAP HANA Studio to stop
replication of tables required
by SAP Customer Activity Re-
pository.

For more information, see
SAP Help Portal at http://
help.sap.com/hanallr SAP
HANA Options # SAP HANA

Real-Time Replication # SAP
HANA Trigger-Based Data
Replication Using SAP LT

Replication Server # System
Administration and

Maintenance Information }
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Software Component Sequence Tool Detailed Description

RTLCAR 5 STOPSAP Log onto the host of your cen-
tral system as the SAP Ad-
ministrator. Enter stopsap
R3.

Note that the R3 switch does
not stop the database simul-
taneously. To do so, use the
command stopsap or

stopsap ALL.

SAP HANA Database 6 sapstartsrv See the information about
starting and stopping SAP
HANA systems in the SAP
HANA Administration Guide.

4.3 Software Configuration

This chapter explains which components or scenarios used by this application are configurable and which tools
are available for adjusting.

Table 13:

Software Component Configuration Tool(s) Detailed Description

RTLCAR SAP Customizing See the documentation in Customizing
for SAP Customer Activity Repository.

RTLPOSDM SAP Customizing See the documentation in Customizing
for SAP Customer Activity Repository
under POS Data Management.

RTLMCFND SAP Customizing See the documentation in Customizing
for SAP Customer Activity Repository
under Retail Multichannel Foundation.

RTLDDF SAP Customizing See the documentation in Customizing
for SAP Customer Activity Repository
under Demand Data Foundation.
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4.4 Administration Tools

SAP Customer Activity Repository uses the standard SAP NetWeaver administration tools. For more information,
see SAP Help Portal for SAP NetWeaver at http://help.sap.com/nw|lr <your release>  System Administration
and Maintenance Information » Technical Operations for SAP NetWeaver » Administration of SAP NetWeaver
systems and components .

SAP Customer Activity Repository also uses the administration tools available with SAP HANA. For more
information, see SAP Help Portal for SAP HANA Appliance software at http://help.sap.com/hana_appliance

|» System Administration » SAP HANA Technical Operations Manual 3.

Periodic Scheduled Tasks

You can automate scheduled tasks using a task scheduler program.
Data Import
e Toimport master data and transactional data into the Demand Data Foundation (DDF) module, you can
schedule automated import tasks using the /DMF/PROCESS STAGING TABLES report (transaction SE38).
For more information, see http://help.sap.com/car|k <your release> » Application Help » SAP Customer
Activity Repository » Demand Data Foundation j» General Services » Monitor Imports # Process Inbound
Staging Tables 3.

e Make sure that the master data is continuously imported into DDF.
If you use an SAP ERP application as your master data system, configure the DRF data replication framework

(transaction DRFOUT) to periodically send the data. For more information, see [ SAP Solution Manager
Business Scenario: Customer Activity Repository  Business Process: Enabling Demand Data Foundation and
Creating Demand Forecast 3 and consult the information on the Documentation and Configuration tabs.

Data Export

e To periodically export regular prices and OPP promotions (outbound) as part of the Omnichannel Promotion
Pricing, you can schedule automated exports using transaction DRFOUT.

Periodic Manual Tasks

A manual task needs a person to execute it. Manual tasks may be required for individual components and are
therefore relevant in each scenario that uses the component. Other manual tasks may be relevant for certain
business scenarios only. It is important that you monitor the successful execution of these tasks on a regular
basis.

For an overview of manual tasks for managing DDF, see the following table.

= Recommendation

You can use transaction SE38 to run programs/reports and display the accompanying documentation.
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Table 14: Manual Tasks for Managing DDF

Tool Supporting the Task

Recommended Frequency

Description

Purge master data

Report /DMF/PURGE_AGENT

As required

You can use this report to
purge master data. For more
information, see the report
documentation.

Delete obsolete time series
data

Report /DMF/TS DELETE

As required

You can select the data to be
deleted by product and by lo-
cation using key figure pa-
rameters ( KPRM). You can de-
lete data for the following
time series types:

e Universal (UN)
® | ocation Universal (UL)
e Point of Sale (POS)

For more information, see the
report documentation.

Delete obsolete exception
message data

Report /DME/
PURGE _EWB MESSAGES

As required

You do not need to specify pa-
rameters for this report. You
can either execute it directly
or schedule it for execution.
Which data is purged depends
on how you have configured
the exceptions in Customizing
and on which deletions are
performed on the user inter-
face.

Table 15: Manual Tasks for Omnichannel Article Availability

Task

Schedule deletion of outdated
ATP snapshot entries

Tool Supporting the Task

Report /oan/
ATP_SNAPSHOT DELETION

Recommended Frequency

As required

Description

If articles are removed from
the assortment of an online
store, availability information
for these articles persists in
the ATP snapshot. The report
removes these entries.

For more information, see the
detailed report documenta-
tion in the system.
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Tool Supporting the Task

Recommended Frequency

Description

Schedule deletion of outdated
temporary reservations that
have built up over time

Report /oan/
ATP_RESV_DELETION

As required

There are two types of reser-
vations: cart reservations and
order reservations. You can
delete all reservations or de-
lete cart reservations only.

For more information, see the
detailed report documenta-
tion in the system.

While it is possible to select
both deletion options, best
practice in business would be
to create and schedule two in-
dependent variants, namely
one per option. The variant for
the Delete all reservations op-
tion could be scheduled to run
every week, while the variant
for the Delete cart
reservations only option could
be scheduled to run every 30
minutes, for example.

Table 16: Manual Tasks for Omnichannel Promotion Pricing

Task

Purge OPP promotion data

Tool Supporting the Task

Report /DMF/PURGE_AGENT

Recommended Frequency

As required

Description

This report purges OPP pro-
motion data as part of the
purging of offers. For more in-
formation, see the system
documentation of the report.

Archive IDocs for OPP promo-
tion outbound and regular
price outbound

| sAP Menu »
Administration > System
Administration >

Administration } and choose
Data Archiving (transaction
code SARA).

As required

For more information about
archiving IDocs, see the docu-
mentation on SAP Help Portal
at Archiving and Deleting
IDocs at http://
help.sap.com/
saphelp_nw70/
helpdata/en/dc/
6b821443d711d1893e0000e8
323c4f/content.htm.
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4.5 Backup and Restore

Use

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of
failure. The backup and restore strategy of your system landscape must not only include your strategy for your
SAP system, but it must also be included in your company's overall business requirements and incorporated into
your entire process flow.

In addition, the backup and restore strategy must cover disaster recovery processes, such as how to recover from
the loss of a data center due to a fire. It is important that your strategy specify that normal data and backup data
are stored in separate physical locations, so that both types of data are not lost in case of a disaster.

SAP Customer Activity Repository is based on SAP NetWeaver technology; therefore, the SAP NetWeaver backup
procedures can also be used for SAP Customer Activity Repository.

More Information

Table 17:

Subject Path

Backup and recovery processes for ABAP, JAVA, Business In- | See the Technical Operations Manual for SAP NetWeaver at
telligence, or Process Integration http://help.sap.com/nw. Choose a release. Choose

|} System Administration and Maintenance Information >
Technical Operations Guide > Technical Operations Manual

for SAP NetWeaver 1

Backup and restore for SAP systems See SAP Support Portal at http://support.sap.com/support-
programs»services/methodologies.htmll‘hrl} Best Practice
> System/Technical Administration: Backup and Restore for

SAP Systems Landscapes }

Backing up and recovering the SAP HANA database See SAP Help Portal for SAP HANA Platform at http://
help.sap.com/hana_appliance. Choose a release. Choose

| System Administration  SAP HANA Administration
Guide 3.
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4.6 Load Balancing

For information about load balancing, see the following references:

Table 18:

Topic Path

Standard functionality of SAP NetWeaver for logon and load
balancing

See SAP Help Portal for SAP NetWeaver at http://
help.sap.com/nw. Choose a release. Under System
Administration and Maintenance Information, choose

|+ Technical Operations Manual for SAP NetWeaver
Solution Lifecycle Management ¥ High Availability » SAP
NetWeaver AS ABAP: High Availability p Unplanned Downtime
for SAP NetWeaver AS ABAP > Service Configuration for
Failure Resilience ¥ Message Server-Based Logon and Load

Balancing (Redirection) ]

Partitioning and scale-out for SAP HANA

See SAP Help Portal for SAP HANA Appliance software at
http://help.sap.com/hana_appliance. Choose a release. Un-
der System Administration and Maintenance Information,

choose |F SAP HANA Administration Guides # SAP HANA
Administration Guide # Scaling for SAP HANA 4.

Partitioning of the /POSDW/TLOGF table

SAP Note 1719282 ¥4 .

Classify TLOG Tables for SAP Customer Activity Repository
Report

See the report documentation (transaction /pPOsSDW/
CLASSIFY TLOG inyour SAP Customer Activity Repository

System) and SAP Note 1980718 .

Optionally, backup and restore for the SAP Landscape Trans-
formation (LT) Replication Server (if you wish to start addi-
tional processes in SLT)

1 Note

For information on deployment options, which determine
whether replication is necessary, see http://

help.sap.com/carlF <your release> ¥ Installation and

Upgrade Information > Installation Guide 4.

See SAP Help Portal for SAP HANA Appliance software at
http://help.sap.com/hana_appliance. Choose a release. Un-
der System Administration and Maintenance Information,

choose |* SAP HANA Technical Operations Manual »
Administering and Operating SAP HANA Replication

Technologies > Backup and Recovery of SAP HANA
Replication Technologies ]

Partitioning for UDF and DDF

See the Partition Tables for UDF and DDF (Optional) section in
the Common Installation Guide at |} <your release> >

Installation and Upgrade Information > Installation Guide }
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Topic

Configure Load Balancing service in DDF

Path

See http://help.sap.com/car|lr <your release> ¥ Application
Help » SAP Customer Activity Repository # Demand Data

Foundation  General Services # Configure Load Balancing 4
(including special considerations for demand modeling and

forecasting with UDF).
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5 High Availability

Use

SAP Customer Activity Repository is based on SAP HANA and SAP NetWeaver technology; all high availability
considerations that apply to SAP HANA and SAP NetWeaver, such as increasing system availability, improving
performance, and eliminating unplanned downtime, also apply to SAP Customer Activity Repository.

More Information

Table 19:

Topic Path

General information on high-availability strategies for SAP
NetWeaver-based systems

See SAP Help Portal for SAP NetWeaver at http://
help.sap.com/nw. Choose a release. Under Application Help ,

choose |} Function-Oriented View > Solution Life Cycle
Management > SAP High Availability ]

General information on high availability strategies for SAP
HANA based systems

See SAP Help Portal for SAP HANA Appliance software at
http://help.sap.com/hana_appliance. Choose a release. Un-
der System Administration and Maintenance Information,

choose |* SAP HANA Technical Operations Manual »
Administering and Operating SAP HANA > High Availability }
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6 Software Change Management

6.1 Introduction

Software Change Management standardizes and automates software distribution, maintenance, and testing
procedures for complex software landscapes and multiple software development platforms. These functions
support your project teams, development teams, and application support teams.

The goal of Software Change Management is to establish consistent, solution-wide change management that
allows for specific maintenance procedures, global rollouts (including localizations), and open integration with
third-party products.

This section provides additional information about the most important software components.

6.2 Transport and Change Management

Component Change Management Tools

Table 20:

Component Solution Manager Maintenance Opti- Transport Management Too

mizer Integration

RTLCAR Yes SAP NetWeaver Transport Organizer
RTLPOSDM Yes SAP NetWeaver Transport Organizer
RTLMCFND Yes SAP NetWeaver Transport Organizer

6.3 Development Requests and Development Release
Management

Use

You use the standard tools and procedures of SAP NetWeaver to transport SAP Customer Activity Repository
code extensions or Customizing changes. All such changes are captured by the transport system and are
transportable.
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More Information

Table 21:

Path

Topic

Change and Transport System See SAP Help Portal for SAP NetWeaver at http://
help.sap.com/nw. Choose a release. Under System
Administration and Maintenance Information, choose

|} Technical Operations for SAP NetWeaver > Administration
of Application Server ABAP } Change and Transport
System 3

Change Management for SAP HANA-based systems See SAP Help Portal for SAP HANA Appliance software at
http://help.sap.com/hana_appliance. Choose a release. Un-
der System Administration and Maintenance Information ,

choose | SAP HANA Technical Operations Manual
Administering and Operating SAP HANA > Change

Management 3

Manual ABAP on SAP HANA correction process See SAP Note 1798895 .

6.4 Support Packages and Patch Implementation

Use

We recommend that you implement SAP NetWeaver, SAP HANA and SAP Customer Activity Repository support
package stacks, which are sets of support packages and patches for the respective product version that must be
used in the given combination. The technology for applying support packages and patches will not change.

You can find detailed information about the availability of SP stacks for SAP Customer Activity Repository on SAP
Service Marketplace at http://service.sap.com/sp-stacksfr. See the corresponding Release Information Notes
(RIN) before you apply any support packages or patches of the selected SP Stack.

Use the Maintenance Optimizer (transaction Dswp) in SAP Solution Manager to select, download, and install the
needed usages, or software components and required support packages.
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More Information

Table 22:
Topic Path
SAP Solution Manager See SAP Help Portal for SAP Solution Manager at http://

help.sap.com/solutionmanager.

SAP Solution Manager Change Management Maintenance Op- | See SAP Service Marketplace at http://service.sap.com/

timizer solman-mopz .
SAP Add-on Installation Tool See the documentation for transaction SAINT in your SAP
system.

Implementation of support packages and possible side effects See http://service.sap.com/patches |', SAP Support

Packages in detail 4.
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7 Troubleshooting

7.1 Troubleshooting Information Specific to On-Shelf
Availability

Viewing Back-End Error Messages

Back end error messages are saved in the Gateway system. To access these error messages, perform the
following steps:

Start transaction /IWFND/ERROR_LOG.

Select the log entry, and choose Error Context.

Choose Application Log.

A wN e

Note down the error number of each message with the following message text: This is an external
message. Access message text via details

5. Choose Detail exists to view the text of each external error message.

Cleaning Up Gateway Cache

You can clean up the cache on the Gateway server by running transaction /IWEND/cache cleanup. Cleaning up
cache on the back end using transaction /IWBEP/cache cleanup is also recommended.

Verifying BAdl Implementations

The On-Shelf Availability functionality requires that the BAdIs found in Customizing under |+ SAP Customizing
Implementation Guide » SAP Customer Activity Repository » On-Shelf Availability » Enhancements Using
Business Add-Ins d have an implementation.

In the case that a BAdI does not have an implementation specific to your business scenario, you can expect the
following behavior from the On-Shelf Availability functionality.

Table 23:

BAdI Missing Implementation Result

Process Shelf Status Change Notifications No error occurs, no on-shelf availability alerts will be reported.
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BAdI Missing Implementation Result

Retrieve Algorithm Detection Time Runtime error in On-Shelf Availability when executing the OSA
algorithm.

Retrieve Department Data Runtime error in OData Service.

Retrieve Sub-Department Data Runtime error in On-Shelf Availability when executing the OSA
algorithm.

Retrieve Product Data Runtime error in OData Service.

Retrieve Additional Product Information Data No error occurs, no additional product information (such as

promotion and layout) will be available.

Retrieve Listed Product Data Runtime error in On-Shelf Availability when executing the OSA
algorithm.

Retrieve Product Inventory Data No error occurs, product inventory information will not be
available.

Retrieve Image URL Data No error occurs, product images will not be available.

Retrieve Store and Factory Calendar Data Runtime error in OData Service.

Troubleshooting On-Shelf Availability Algorithm Results

The following Customizing settings under |» SAP Customizing Implementation Guide » SAP Customer Activity

Repository » On-Shelf Availability ¥ Initialize On-Shelf Availability Algorithm 3 can have the most impact on the
results of the OSA algorithm:

42

Level Of Granularity

This setting impacts on which level the intra-week pattern analyzer step of the OSA algorithm will be
executed: on product, sub-department or store level. For example, when the Level of Granularity is set to
2000, you need transactional information containing 2000 x 2.5 times the number of instances at which the
product was sold during the period specified in the Number of Weeks setting. To run the intra-week pattern
analyzer step at the product level, the product must have been sold 5000 times at the store considered by the
algorithm. To run the intra-week pattern analyzer step at the sub-department level, products of that sub-
department must have been sold 5000 times at the store considered by the algorithm. To run the intra-week
pattern analyzer step at the store level, 5000 products must have been sold by the store in the specified
Number of Weeks setting.

Minimum Transaction Threshold

This setting determines which products will be considered when the estimation model step of the OSA
algorithm is executed: products included in fewer transactions than specified in the Minimum Transaction
Threshold setting during the period specified in the Number of Weeks setting will be excluded. For example, if
the Minimum Transaction Threshold setting is 50 and the Number of Weeks is set to 13, then a product will be
excluded by the estimation model if it is sold in fewer than 50 transactions during a 13 week period.
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7.2 Troubleshooting Information Specific to Omnichannel
Article Availability (OAA)

Table 24:

Symptom

In SAP Hybris Com-
merce, there is no availa-
bility information in the
cart.

Cause

Availability data could not
be retrieved from SAP
Customer Activity Reposi-
tory.

Solution

Check whether the SAP Customer Activity Repository system is up
and running.

If the SAP Customer Activity Repository system is up and running:

In SAP Hybris Commerce, check the log files. Requests and responses
for the 3 OAA REST services are logged in the standard application log
files of SAP Hybris Commerce. For error analysis, set the log4j log level

for logger package com.sap.retail.oaa.commerce.services to
DEBUG in the hybris administration console (hac), under |} Platform >
Logging } Repeat process and check log files again.

If there are errors in the log files: In SAP Hybris Commerce, check
whether Backoffice Customizing is correct.

If there are no errors in the log files: Check whether the OAA tables
have been replicated from SAP Retail to SAP Customer Activity Repo-
sitory (SLT replication, see SAP Note 2263205#%).

For OAA, the following tables must be replicated via SLT:

e VBAK
° MARA
e MARM
e TOOIW

e Tables required for Inventory Visibility view
sap.is.retail.car/

InventoryVisibilityWithSalesOrderReservedQuantity

If SLT replication is okay: In SAP Customer Activity Repository, check
the ATP snapshot (transaction SE11, table /OAA/ATP DC_HDR
and /OAA/ATP DC_ITM, external view /OAA/STORE AVAIL).

If these tables and this view are empty: In SAP Customer Activity Re-
pository, check whether report /OAA/ATP CALL PRECALC was sched-
uled (transaction SM37) and was executed successfully (transaction
SLG1, object /0AA/ATP).

If the report was executed successfully: In SAP Retail, check scheduled
jobs (transaction SM37; see prefix for jobs set in ATP profile in Cus-
tomizing activity Define ATP Parallelization Profiles).
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Symptom

In SAP Hybris Com-
merce, rough stock indi-
cators (RSI) are not up-
dated.

Cause

RSI data has not reached
the Solr index in SAP Hyb-
ris Commerce.

Solution

In SAP Customer Activity Repository, check whether the RSI IDoc was
sent (transaction SM37: job monitor of report /oA /
ATP_RSI GENERATION).

If the IDoc was not sent: Check whether errors occurred during gener-
ation of the IDoc (transactions WEQ5, BD87). If the IDoc was sent: In
the Backoffice application of SAP Hybris Commerce, check whether
the rough stock indicators exist in the virtual warehouse that is to be
the receiver of this information.

If the rough stock indicators do not exist in the virtual warehouse,
check the standard logging of the Hybris Data Hub. You can access the
information contained in the Hybris Data Hub directly using the follow-
ing standard browser GET requests:

e http://localhost:8080/datahub-webapp/vl/pools/
SAPOAARSI_INBOUND_POOL/items/RawCARRsi.xml

e http://localhost:8080/datahub-webapp/vl/pools/
SAPOAARSI_INBOUND_POOL/items/CanonicalStockLevel.xml

If the rough stock indicators exist in the virtual warehouse, check
whether the Solr index was updated correctly.

In SAP Hybris Com-
merce, the error mes-
sage Failed to place the
order is displayed when
you click Place Order in
checkout.

Sourcing was called but
might have failed.

Check the logs in SAP Hybris Commerce for error messages.

In SAP Customer Activity
Repository, there is no
F4 help available for ATP
parallelization profiles in
Customizing activity
Define OAA Profiles.

Table OAA_ATP_PROFILE
has not been replicated
from SAP Retail.

Check SLT replication (see SAP Note 2263205/ ).
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8 Support Desk Management

Use

Support Desk Management enables you to set up an efficient internal support desk for your support organization
that seamlessly integrates your end users, internal support employees, partners, and SAP Active Global Support
specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure to
run your internal support organization efficiently.

Remote Support Setup

You can set up a read-only user for remote support purposes that provides access to the consuming applications
and SAP NetWeaver transactions.

The following roles should be assigned to this user:

e sap oAP BC_sHOW (for SAP NetWeaver)
® Role of the consuming application

If you want to use SAP remote services (for example, SAP EarlyWatch or Remote Consulting), or if you would like
to permit an SAP support consultant to work directly in your system to make a more precise problem diagnosis,
then you need to set up a remote service connection.

Additionally, there exists an ABAP role for read-only access for remote support that is also relevant. This role
(sap_RcA SAT DIsPfor ABAP)isavailable inthe STPI plug-in and is generated when a managed systemis
connected to SAP Solution Manager.

Should any additional application-specific functionality be necessary for use by an SAP support consultant, then
an applicable role should be defined providing the appropriate authorization(s) and assigned to the SAP support
consultant's user login.

Reporting Customer Incidents

When you report an incident (that is, create an SAP support message) for your installation, you must specify an
application component. The most relevant components for SAP Customer Activity Repository are listed as
follows:

® CA-RT-CAR-PIP -toreportanincident for the POS Data Transfer and Audit module (POS Data
Management).

® CA-DDF-RT -toreport anincident for the Demand Data Foundation (DDF) module.

® CA-DDF-RT-UDF - to report an incident for the Unified Demand Forecast (UDF) module. This includes
messages relating to the UDF AFL and the Analyze Forecast SAP Fiori app.

® CA-RT-CAR-INT -toreportanincident for integration with the DDF/UDF modules and integration between
the repository and consuming applications.

® CA-RT-CAR-ANA - toreport anincident for SAP HANA content delivered with SAP Customer Activity
Repository.

® CA-RT-CAR-OAA - toreport anincident for Omnichannel Article Availability that is related to SAP Customer
Activity Repository
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LO-MD-PL and LO-MD-OAA - to report an incident for Omnichannel Article Availability that is related to SAP
Retail
CEC-COM-BSC-0AA - to report an incident for Omnichannel Article Availability that is related to OAA standard
extensions and OAA Data Hub extensions of SAP Hybris Commerce, integration package for SAP for Retail

® CA-DDF-RT-PPR -to report anincident for Omnichannel Promotion Pricing (OPP) that is related to SAP
Customer Activity Repository.

® CA-RT-CAR-toreportanincident for general issues with SAP Customer Activity Repository that cannot be
easily classified into one of the categories above.

For a complete component list, see the SAP Support Portal at http://support.sap.com/swdc# |l Software
Downloads ¥ By Alphabetical Index (A-Z) » C » CAR RETAIL APPLICATIONS BUNDLE » CAR RETAIL APPL
BUNDLE 1.0 ¥ Info » Customer Support 4.

More Information

e |fthe incident relates to a SAP HANA component, see SAP Note 1976729#% for a complete component list.

e For more information about reporting incidents, see the SAP Support Portal at http://support.sap.com/ #e
| Knowledge Base & Incidents » Report an Incident .

e For contact information for your local customer interaction center, see SAP Note 560499 # .
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9 Appendix

9.1 Transaction Log (TLOG) Data Model and Storage

POS data is captured in a format called a Transaction Log (TLOG). TLOGs capture all the attributes of a store's
sales transaction. This information is used to log many attributes about the sale, such as customer information,
sales price, discount price, quantities, item descriptions, and much more. Such information is used in backend
store systems for sales auditing, reporting, and input in to additional Retail planning applications.

SAP Customer Activity Repository is an application that serves as a central repository for storing TLOG data. In
addition to storing and providing many business functions that operate directly on the TLOG data (for example,
Sales Audit), SAP Customer Activity Repository also captures and exposes the data in a standard way so that it
can be easily consumed by analytical, planning, and other follow-on applications.

Business Transactions

The POS transaction data model is the most important business object in the POS Inbound Processing Engine
(PIPE). At the POS, different kinds of business transactions can be recorded by a cash register, for example:

e POSsales

e Cash pay-in/pay-out

e [nventory Adjustments (for example, spoilage or unexpected goods receipt)

e Register closing (for example, count cash amount in the till)

e Statistical events (for example, cash drawer opened, store opening, and cashier log on)

In order to simplify the programming interfaces, the SAP Customer Activity Repository POS transaction data
model is based on a generic approach that allows different kinds of POS transactions to be stored in the same
database tables. A qualifier, called a transaction type code, is used to distinguish which kind of business
transaction the POS transaction reflects. For one business transaction, there can be more than one transaction
type. For example, a retail transaction can be either a sale or an employee sale, but both are sales transactions.

The figure Business Transaction Types for POS Transactions shows the business transactions that can be used to
classify generic POS transactions. Technically, this classification is used to define a subset of segments that can
be used by a specific business transaction. For example, a financial transaction may not include any goods
movement items because this sub-structure belongs to goods movement transactions only.

Located at the header level of a POS transaction, the business transaction field uses fixed values to indicate the
transaction type, as shown in this figure.

SAP Customer Activity Repository 2.0 SP4 Operations Guide
Appendix CUSTOMER 47



FOS
Transaction

(

f

(

W

3

]

Retail Financial Goods Totals Control Reversal
Transaction Transaction Movement Transaction Transaction Transaction
Transaction

Figure 2: Business Transaction Types for POS Transactions

The following sections describe the relationship of the POS transactions on the segment level. Segments are
stored in internal tables. They can contain more than one line. Although it is technically possible to store multiple
lines in all segments, some segments may contain only a single record. In the following sections, the hierarchy of
the segments and the cardinality is explained in detail.

Common Segments

Transaction Header

All POS transactions share the same header segment. Some header fields are mandatory and must be filled out in
order for SAP Customer Activity Repository to process the data. Some header fields are optional in SAP
Customer Activity Repository but are required from a business point of view.

The transaction header contains the following information:

Table 25: Transaction Header Fields

Role in SAP Customer | Role at POS

Activity Repository

Data Type/Length

Field Name Description

Retail Store ID A unique identifier of Key Key Char/10
the store where the
POS transaction was
entered. This field usu-
ally contains the cus-
tomer number of the
plant in ERP to which

the store is assigned.
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Field Name

Description

Role in SAP Customer

Activity Repository

Role at POS

Data Type/Length

Business Day

The date to which the
POS transaction is as-
signed. In Retail, itis re-
ferred to as the busi-
ness day or posting
date. In some cases,
the business day is not
the actual date on
which the transaction
transpired but to which
itis assigned. For ex-
ample, ina 24/7 busi-
ness, a cashier's work
shift can be from 23:00
until 03:00 and sales
transactions that tran-
spire after 00:00 are
assigned to the previ-
ous day.

Key

Key

Date

Transaction Index

A counter that uniquely
identifies POS transac-
tions for the same store
and same business
day. This field is availa-
ble only in SAP Cus-
tomer Activity Reposi-
tory and has no repre-
sentation in the exter-
nal interfaces or at the
POS.

Key

Integer/4

Transaction Type Code

A four-digit code used
to indicate the type of
POS transaction.

Mandatory Attribute

Mandatory Attribute

Char/4

Workstation ID

A number that identi-
fies the cash register or
machine where the
POS transaction was
entered.

Optional Attribute

Key

Char/10
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Field Name Description Role in SAP Customer | Role at POS Data Type/Length
Activity Repository
Transaction Number A number used to iden- | Optional Attribute Key Char/20
tify a POS transaction.
In SAP Customer Activ-

ity Repository, the key
fields (store, business
day, workstation ID,
transaction type code,
and transaction num-
ber) do not need to be
unique because SAP
Customer Activity Re-
pository uses a counter
at the database level.
However, the key field
combination must be
unique at the POS.

Begin Time Stamp The date and time the | Mandatory Attribute Mandatory Attribute Char/14
POS transaction was
started. When the
cashier enters a new
POS transaction, the
time is stored in the
transaction header.
This information is re-
quired to put the trans-
actions in sequential
order, and is also used
to assign retail transac-
tions to totals transac-
tions (see Totals Trans-
actions) for the balanc-
ing or short/over calcu-
lation.
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Field Name

Description

Role in SAP Customer

Activity Repository

Role at POS

Data Type/Length

End Time Stamp

The date and time the
POS transaction was
completed. This field is
mandatory in SAP Cus-
tomer Activity Reposi-
tory. It may be filled
with the begin time
stamp, unless a second
time stamp is available.
By completing a POS
sale, the time stamp is
also entered in the
transaction header.

Mandatory Attribute

Optional Attribute

Char/14

Department

A number that identi-
fies the department of
the store.

Optional Attribute

Optional Attribute

Char/10

Operator ID Qualifier

Itis used to identify the
cashier who entered
the POS transaction or
the user who entered
the business transac-
tion.

Optional Attribute

Optional Attribute

Char/30

Operator ID

Itis used to identify the
cashier who entered
the POS transaction or
the user who entered
the business transac-
tion.

Optional Attribute

Optional Attribute

Char/30
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Field Name

Description

Role in SAP Customer

Activity Repository

Role at POS

Data Type/Length

Transaction Currency

The transaction cur-
rency to which all retail
line items are assigned.
For retail transactions,
this field is optional be-
cause all retail transac-
tions in the same store
are usually assigned to
the same currency,
even if the payment can
be done in different
currencies. The trans-
action currency can dif-
fer from the tender cur-
rency. If the transaction
currency is not pro-
vided, a default cur-
rency must be defined
in the SAP Customer
Activity Repository
Customizing. However,
for tender totals, the
field is mandatory as
there can be totals for
different currencies.

Attribute

Optional attribute

Char/5

Partner ID Qualifier

This field indicates if
the transaction is from
a customer or business
partner.

Optional Attribute

Optional Attribute

Char/1

Partner ID

Itis used to store the
SAP customer number,
SAP personnel number,
or a free text value.

Optional Attribute

Optional Attribute

Char/13

Receipt Handling Time

Specifies the time, to
the millisecond, re-
quired to complete the
handling of the receipt.

Optional Attribute

Optional Attribute

Dec/13,3

Register Time

Specifies the time, to
the millisecond, re-
quired for the register-
ing of the transaction
line items.

Optional Attribute

Optional Attribute

Dec/13,3
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Field Name Description Role in SAP Customer | Role at POS Data Type/Length
Activity Repository
Tendering Handling Specifies the time, to Optional Attribute Optional Attribute Dec/13,3
Time the millisecond, re-
quired to complete the
transaction payment
(tender).
Pause Time Specifies the time, to Optional Attribute Optional Attribute Dec/13,3
the millisecond, that
the cash register
spends in pause mode
between two transac-
tions.
Training Time Specifies the time, to Optional Attribute Optional Attribute Dec/13,3
the millisecond, that
the cash register
spends in training
mode.
Drawer Number Used | Specifies the cash Optional Attribute Optional Attribute Char/10
at POS Client drawer identifier used
ata POS client.
Customer ID from POS | Specifies the customer | Optional Attribute Optional Attribute Char/16
identifier.
Customer Age Specifies the age of the | Optional Attribute Optional Attribute Integer/5
customer.
Customer Identifier En- | Specifies the method Optional Attribute Optional Attribute Char/1
try Method used to enter the cus-
tomer ID.
Reference to Original Specifies the retail Optional Attribute Optional Attribute Char/10
Receipt for Retail Store | store identifier of the
ID referenced transaction.
Referenced to Original | Specifies the posting Optional Attribute Optional Attribute Date
Receipt for Posting date of the referenced
Date transaction.
Reference to Original Specifies the POS num- | Optional Attribute Optional Attribute Char/10
Receipt for Workstation | ber (cash register num-
ID ber) of the referenced
transaction.
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Field Name Description Role in SAP Customer | Role at POS Data Type/Length
Activity Repository
Reference to Original Specifies the transac- | Optional Attribute Optional Attribute Char/20
Receipt for Transaction | tion identifier (receipt
Number number) of the refer-
enced transaction.
Reference to Original Specifies the start Optional Attribute Optional Attribute Char/14
Receipt for Start Time- | timestamp, as appears
stamp on the referenced
transaction
Reference to Original Specifies the original Optional Attribute Optional Attribute Char/10
Receipt for Line Item line item number of the
Number referenced transaction.
Reason Specifies the reason Optional Attribute Optional Attribute Char/4
code for referencing
data from the original
receipt.
Logical System |dentifies the source Optional Attribute Optional Attribute Char/10
system for data

Post Void Details

Post void details are included in the header information. Post void details provide two types of information:

e Aflagto mark atransaction to be voided

e Areference to another transaction that was voided. Note that this information can only be part of a post void

transaction. See Post Void Transactions.

Any POS transaction can be flagged to be voided; therefore the structure for post void details can be used in
combination with all business transaction types. However, only post void transactions can contain a reference to a

voided transaction.

SAP Customer Activity Repository tasks can be configured to filter out voided transactions automatically.

For more information on post void details, see Post Void Transactions.

Extensions

The POS transaction data model used by SAP Customer Activity Repository includes predefined locations where
you can insert extension segments to enhance the standard data model with customer-specific fields.

Extensions can exist on different levels in a transaction, therefore extension segments can occur on the
transaction header level, on the item level (for example, retail line item, tender, or goods movement item), or even
lower than the item level.

For more information, see Extensibility and Extensions.

Transactional Additionals
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The transaction additionals segment contains information about the entry of the transaction, for example, a
transaction reason code or a training transaction indicator.

Retail Transactions

A retail transaction contains the most relevant information about a POS sale, such as retail line items and tender
information.

A retail line item reflects a quantity of a single article that was scanned or manually entered at the POS. For each
retail line item, there can be discounts, taxes, loyalty information or commission information that applies to it.
Depending on the business case or business use, discounts, taxes, and loyalty information may can also exist at
the transaction level.

Some fields in the retail line item are used very rarely. These are stored in a sub-structure called retail

additionals.

After all items have been entered at the POS, and the customer has paid, the relevant information is stored in the
tender segment, which stores information about the means of payment. For credit card or debit card
payments, there are sub-structures that contain information about the card number, card owner, and the
authorization code sent by the credit card authorization service. If the credit card information is available only in
an encrypted format, it is stored in the secure bin data segment.

Information about the customer, such as age, phone number and, address, can be added at the POS by use of the
customer details structure which offers the same kind of enhancement concept as the extensions
structures (see Extensibility and Extensions).
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Figure 3: Structure of a Retail Transaction

Totals Transactions

Totals transactions are used to process aggregated information for different kinds of POS transactions such as:

e Retail Totals: Aggregated retail amount and number of items for each retail type code
e Tax Totals: Aggregated tax amount and number of items for each tax type code
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e Discount Totals: Aggregated reduction amount and number of items for each discount type code

e Tender Totals: Aggregated tender amount, number of items, actual amount, short amount, over amount,
removed amount, and other details for each type code

e Cashier Totals: Aggregated statistical information for loss prevention purposes, for example, the number of
retail transactions with a value of zero, the number of cash drawer openings, and other details

At the end of a day or a cashier shift, the cash register can send a summary record that contains these different
kinds of totals.

The summary information has different purposes:

e Technical Balancing: Identifies missing or duplicate detailed information by comparing the summary records
and POS transactions

e Short/Over Processing: Identifies differences between the actual amount and the expected tender amount
(especially cash) at a workstation or cashier level, and sends the differences to financials

e | oss Prevention: Identifies fraudulent activities at the POS by use of statistical patterns, especially the cashier
totals

Technically, it is possible to include different kinds of totals in the same totals transaction.

As arule, the two time stamps that are part of the transaction header are used to identify the time interval for
which the totals have been calculated. If the attributes at the header level, such as operator ID or workstation ID
(see Transaction Header) are filled, the summary information is associated to a specific cashier or cash register.
Otherwise they are valid for all cashiers or workstations.
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Totals
Transaction

Goods Movements

Goods movement transactions are used to enter goods movements at the POS. They can be entered for reasons

such as:

e Spoilage: In this case, the quantity of goods available for sale is decreased and has to be adjusted in inventory

management
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e Transfer posting: Goods can be transferred from one store to another without any kind of settlement

® Reserve goods: A customer can call and ask to reserve an article for pickup the next day. If this transaction is
to be reflected in the inventory account, the article can be transferred from the stock at hand to the reserved
stock.

The goods movement transaction consists of a transaction header and a number of goods movement items,
reflecting the inventory-related movement at the article level.

Goods 1 0. 1 | Transaction

Movement ’f Additionals

Transaction

0. 1 | Post Void Details

1 * Soods 1 *| Extensions
1 Movement ltem el

¥ | Extensions

Figure 5: Structure of a Goods Movement Transaction

Financial Movements

Financial movements represent financial transactions with or without an impact on the cash amount at the POS,
such as:

e (Cashremovals or deposits: Money is removed from the cash register, for example, as a deposit it is brought
to the bank, or new change is paid-in. In these cases, the financial amount is moved within the company.

e Pay-Inand Pay-Out Transactions: For example, money is paid-in for services, wages, or a pay-in for a
customer, or paid-out for wages. In these cases, the financial amount is moved out of or into the company.

The financial transaction consists of a transaction header and a financial movement item, which contains an
amount of money to be booked on a certain account.
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Figure 6: Structure of a Financial Movement Transaction

Control Transactions

Control transactions represent events that are tracked for statistical reasons only or to document certain
processes, such as:

Cashier Logon/Logoff or Logon Attempt: For loss prevention purposes, data about the time when a cashier
logged on and off a cash register is collected

Open Register/Close Register: For loss prevention purposes, data about the time when a cash drawer was
opened without a corresponding sales transaction is collected

Repeat Printout: Records when a cashier prints out for a second time
Store Opening: The time the store opens
Suspend/Retrieve Transaction: For detecting fraud patterns, data about suspended transactions is collected

A control transaction consists of a transaction header. It is classified by a transaction type code and a timestamp.
If more information needs to be transferred, an extension segment can be used.
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Figure 7: Structure of a Control Transaction

Post Void Transactions

A post void transaction represents the reversal of a POS transaction that was previously processed. For several
business reasons and in unusual cases, it can be necessary to cancel an entire POS transaction, for example, if a
POS sale has been completed but the customer is not able to pay, or a goods movement was booked by mistake.

There are two possible post void scenarios:

1. The original POS transaction has already been processed in the back-end system.
In a trickle-feed scenario, POS transactions are sent to SAP Customer Activity Repository many times during
the day. In this case, the original POS transaction has already been processed and can no longer be marked as
a voided transaction at the cash register.

2. The original POS transaction has not yet been transferred to the back-end system.
Because sales transactions are uploaded only once a day, the cash register will automatically flag the original
POS transaction to be voided. In this case, no post void transaction is necessary because the original sale can
be flagged as a voided sales transaction.

In the second case, the post void transactions need to be transferred to SAP Customer Activity Repository
because the cash register has already marked the original transaction to be “invalid”. If this is technically not
possible or if the first case applies, the reversal processing needs to be done in SAP Customer Activity Repository.
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Figure 8: Post Void Transactions

POS Transaction Tables (/POSDW/TLOGF)

In SAP Customer Activity Repository, POS transactions are stored in one table, the /PosDW/TLOGF table. This
table has the following characteristics:

e Persisted only in the SAP HANA database
e No BLOB fields
e Column-based

e (Canstore up to two years of non-aggregated POS transaction data. Note that the amount of data stored is
deployment-specific and is determined by the customer.

/POSDW/TLOGF Table

In the SAP Customer Activity Repository application layer, /POSDW/TRANSACTION INT structureis the internal
representation of the pos transaction data.
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In the database layer, the pPOs transaction data is stored in the /POSDW/TLOGF table.

The /POSDW/TLOGF table is a column-based, flattened version of the /POSDW TRANSACTION INT structure,
where all the fields of the structure are stored in one table.

Flattening the TLOG Data Model into /POSDW/TLOGF

As described in the previous sections, POS transactions are stored as a tree structure in /POSDW/
TRANSACTION INT. The root node of a POS transaction contains header information such as transaction type
and transaction number. The header fields are common to all POS business transaction types. In addition to the
header fields, there are tables in the data structure that represent information from different business transaction
types.

In order to transform this tree structure into a flat table (that is, a table that contains no additional tables), the
approach is similar to the approach previously used by SAP POS DM 1.0 to supply BW DataSources: a record
qualifier attribute is introduced for each row. This is not the same record qualifier that was used for POS analytics.
Although similar, the /POSDW/RECORDQUALIFIERID data element is specific to the /POSDW/TLOGF table. For
more information, see SAP Note 811393 .

For a flattened TL.0G data model ( /POSDW/TLOGF), the following record qualifiers are used:

Table 26: Record Qualifiers

Record Qualifier Description

1 Transaction Header

2 Post Void Details

3 Additionals

4 Customer Details

5 Retail Line Item

6 Discount

7 Discount Extension

8 Tax

9 Tax Extension

10 Line Item Void

1 Line Item Discount

12 Line Item Discount Extension
13 Line Iltem Tax

14 Line Iltem Tax Extension
15 Line Item Commission

SAP Customer Activity Repository 2.0 SP4 Operations Guide
64 CUSTOMER Appendix


http://help.sap.com/disclaimer?site=https://launchpad.support.sap.com/#/notes/811393

Record Qualifier Description

16 Line Iltem Extensions

17 Line Iltem Retail Additionals
18 Line Item Loyalty

19 Line Item Loyalty Extension
20 Line Item Refund Details

21 Tender

22 Financial Movement

23 Goods Movement

24 Goods Movement Extension
25 Extension

26 Loyalty

27 Loyalty Extension

29 Financial Movement Extension
30 Tender Credit Card

31 Tender Direct Debit

32 Tender Fleet

33 Tender Extension

34 Retail Totals

35 Tax Totals

36 Tender Totals

37 Cashier Totals

38 Cashier Totals Extension
39 Discount Totals

40 Tender Coupon

Extensibility and Extensions

As comprehensive as the SAP Customer Activity Repository POS transaction data model is, you can enhance it if
you need to store non-standard data directly in each transaction record. For example, you can store comments
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that a cashier enters about a particular POS transaction directly in the POS transaction log. There are no standard
fields to store cashier comments in the TLOG data model, therefore you use an extension segment.

Extension segments support customer-specific fields by storing them without having to alter the table definition.
The extension segment concept also provides customers with the flexibility to store and process the extensions
together with the rest of the transaction.

Extensions and the Internal TLOG Structure (/POSDW/TRANSACTION INT)

The SAP Customer Activity Repository POS transaction data model handles customer enhancements and
extensions by including tables of name-value pairs (/POSDW/TT_ EXTENSIONS with line type /POSDW/
EXTENSIONS) at predefined locations as extension segments.

N EISD Structure /POSDW/EXTENSIONS Customer Enhancements
¥ 0 Include structure /POSDW/EXTENSIONS_FI Customer Enhancements
¥ 00 Include structure /POSDW/EXTENSIONS_FD Customer Enhancements - Database Fields
- & FIELDGROUP /POSDW/FIELDGROUP Field Group CHAR 5
- {3 FIELDNAME /POSDW/FIELDNAME Field Name CHAR 10
* O FIELDVALUE /POSDW/FIELDVALUE Field Value CHAR 40
» 00 Include structure ;’POSDW{EXTENSIONS_FU User Interface Data: Customer Extension

Figure 10: /POSDW/EXTENSIONS Structure

These extensions exist on different levels: there are extension segments at the header level, at the item level (such
as retail line items, tender movement items or goods movement items), and at lower levels. The field names can
be grouped in order to reproduce data structures.
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Figure 11: Extension Level Details

Extensions and the Physical Data Storage

By default, customer extensions are carried through and stored in the /POSDW/TLOGF table as a name-value pair,

but using dedicated extension record qualifiers.

For example, if a transaction header includes the cashier's comment for the transaction, a record (with a record
qualifier 25) is inserted in the /POSDW/TLOGF table, and this record includes the extensions information as a

name-value pair. FIELDGROUP can be set to COMNT (comments), FIELDNAME to CASHIER (another value could be

MANAGER) and FIELDVALUE can store the comment, for example, "Customer was happy about sale on jeans".
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In the /POSDW/TLOGF table, you would see the following:

Data Browser: Table /POSDW/ TLOGF Select Entries 200
& M4 ETFERSH check Tablk...

MANDT | RETAILSTOREID | BUSINESSDAYDATE | TRANSINDEX| ROWHEY | PARENTHEY | REC IFIER | TRANSTYPECODE FIELDGROUP | FIELDNAME | FIELDVALUE

| 100 |R10o 01.10.2012 1 0 0 1 1001 COMNT CASHIER | Customer was happy about sale on jeans

Figure 12: Example in /POSDW/TLOGF table

Storing Extension Segments in a Separate Table

If you have a large number of extensions, they can significantly increase the size of the /POSDW/TLOGF table, and
potentially slow down database operations on the table.

To speed up database operations on the /POSDW/TLOGF table, you can store extension segments in a dedicated
table (/POSDW/TLOGF_ EXT) by enabling the Store Extensions in Separate Table option in the Define General
Settings Customizing activity.

The setting of the Store Extensions in Separate Table option affects how POS transaction data is stored in the
database. This option should be set after consultation with a SAP Customer Activity Repository administrator,
and you should not change the selected setting of the Store Extensions in Separate Table option needlessly.

Only transactions processed after the Store Extensions in Separate Table option is enabled will have their
extension segments stored in the /POSDW/TLOGF EXT table. For all the POS transactions already stored in the /
POSDW/TLOGF table, you must run the Transfer POS Transaction Extension Segments Report (transaction /
POSDW/REFE) to move the extension segments from the /POSDW/TLOGF table to the /POSDW/TLOGF_EXT table.

If you have been storing extension segments in the /POSDW/TLOGF EXT table, you can use the Transfer POS
Transaction Extension Segments Report to move the extension segments back to the /POSDW/TLOGF table.
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Note that the actual persistence location of extension segments ( /POSDW/TLOGF or /POSDW/TLOGE_EXT) has no
impact on the inclusion of these extension segments in their corresponding transaction records during task
processing, display in the POS Workbench or analysis.

Mapping Extension Segments

If you have a large number of extensions, they can significantly increase the size of the /POSDW/TLOGF and/or
the /POSDW/TLOGF EXT tables, and potentially slow down database operations on the tables. Additionally, if you
would like to consume extension data for analytical purposes, the standard storage of extensions may not yield
adequate performance for the retrieval of this type of information.

To optimize the storage of extension segments, you can define how a given name-value pair for a specific store
extension segment should be mapped instead into a new dedicated field within either the /POSDW/TLOGF or /
POSDW/TLOGF X tables by providing this criteria in the Maintain TLOGF Customer Enhancement Field Mapping
Customizing activity. The new dedicated fields are defined using an APPEND structure on the relevant targeted
table ( /POSDW/TLOGF or /POSDW/TLOGF_X).

The definition of extension field mapping criteria in the Maintain TLOGF Customer Enhancement Field Mapping
customizing activity affects how POS transaction data is stored in the database. This option should be set after
consultation with a SAP Customer Activity Repository administrator. You should not change the defined criteria of
the Maintain TLOGF Customer Enhancement Field Mapping Customizing activity without taking proper
precautions, since any changes can have potentially negative impacts.

Only transactions processed after the definition of the field mapping criteria in the Maintain TLOGF Customer
Enhancement Field Mapping Customizing activity will have their extension segments stored in the /POSDW/TLOGF
or /POSDW/TLOGF X table. For all the POS transactions already stored in the /POSDW/TLOGF & /POSDW/
TLOGF_EXT tables, you must run the Transfer POS Transaction Extension Segments report (transaction /posDw/
REFE) to move the extension segments from the /POSDW/TLOGF or /POSDW/TLOGF EXT table to the proper
targeted field of the targeted table (either the /POSDW/TLOGF or /POSDW/TLOGF X table).

If you have been previously mapping extension segments in the /pPOSDW/TLOGF and/or /POSDW/TLOGF X tables
and you wish to make a change or undo this mapping, you can use the Transfer POS Transaction Extension
Segments report to move the extension segments back to the regular name-value pair storage in the /pPosDw/
TLOGF or /POSDW/TLOGF_EXT table.

1 Note

The actual persistence location of extension segments ( /POSDW/TLOGF, /POSDW/TLOGF EXT, or /POSDW/
TLOGF_X) has no impact on the inclusion of these extension segments in their corresponding transaction
records during task processing, display in the POS Workbench or analysis.
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9.2 TLOG API

The following function modules are used to perform standard CRUD operations on the /POSDW/TLOGF table:
® /POSDW/READ_TLOG
® /POSDW/WRITE TLOG

® /POSDW/SEARCH TLOG

These function modules are part of the /PoSDW/TLOG_APT function groups that reside in [ /POSDW/STRUC ¥ /
POSDW/PIPE » /POSDW/DATABASE 1.

{POSDOWITLOG_API

FM [POSDW/

IPOSDW/WRITE
FM /POSDW/READ_TLOG FM :._TLOG SEARCH_TLOG

ausess

Y
aabitracls
/POSDWICL_DAT.

Signature Change: <DATASODACE
fetch_next_tlog() > fetch_next_tlog_ds() st o {aad 1 chack 2 gy 1)
write_tiogs{) -> write_togs_ds{) ..._-..,,[-,.,“?. ¥ check |_Bog type Foswbog)
road_togl). = read_tiog de() ::'u{m:mfﬁ.;ﬂ # ¥ogs)
saarch_tlog() -> search_tlog_ds{} open_Bog_seahi) e

fead_singde togh ineed to check ¢_tiogd ype fosdwiliogl)

reineve_lieg_timestampd)

weanch_Tegicheck ¢l fog type by = Bogs)

{POSDW/
CL_DATA_SOURCE_BUFFER et S G B B
[ ] TLOGS!
POSDW/ 1POSDW/
CL_DATA_SOURCE_ARCHIVE CL_DATA_SOURCE_AR_HDB_F

/POSDW/
CL_DATA_SOURCE_FLAT_HDB

)

Figure 13: Structure of TLOG_API

The following APIs are used to perform standard CRUD operations on the /POSDW/TLOGF table:

Table 27: APIs used for the /POSDW/TLOGF Table

Description

/POSDW/READ_TLOG Function Module This function module reads the
POS transactions from the
POS transaction database.
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Name

/POSDW/SEARCH_TLOG

’Type

Function Module

Description

This function module searches
the POS transaction database
for records matching the selec-
tion criteria.

/POSDW/WRITE_TLOG

Function Module

This function module writes the
POS transactions to the POS
transaction database. Existing
records with the same key are
overwritten.

/POSDW/CL_DATA_SOURCE_FLAT_HDB Class

Represents the Data Access
Object used to perform basic

table CRUD operations.
[POSDW/
[POSDW/TLOG API|  |/POSDW/SETTINGS Lo CL DATA SOURCE FLAT
AUTHORITY CHECKS HDB
Iposdwiread _tlog | |
/posdw/setlings S

Iposdw/authority_transdata

return transaction

e ek

Figure 14: Sequence Diagram for /POSDW/READ_TLOG Operation
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[POSDWI/
[POSDW/ [POSDW/ CL _DATA SOURCE FLAT

P W/T APl TREX T P WIT AP [P WISETTIN AUTHORITY_CHECKS on
fposdw/search_tlog I | | | I |
execute_search __| | I | I
N T T | | | |
5 Y IS, | | | |
E— > | |
= 5 [ —— pposdw/adthority_transdata i |
I | i ) s-ea_rc-h-tE:gT-El _

return transaction e i e o i e TTI
|

Figure 15: Sequence Diagram for POSDW/SEARCH_TLOG Operation
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Enhanced Fields

Figure 16: Sequence Diagram for /POSDW/WRITE_TLOG Operation

[POSDW/
(POSDW/ [POSDW/ CL DATA SOURCE FLAT (POSDWI
[POSDWI(TLOG API oL PCATREGURITYTE (POSDW/SETTINGS | |\ /7 0RTY CHECKS o5 TREX WRITE INDEX
Iposdwlwrite_tl | I | | I I
og
| | I | |
= ——— Iposdwiettings _l [ I |
L I ___ I | |
- iifofity, transdata ot
t } ™ | |
I A I il i Write_tiog ds | |
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Enhanced fields are not stored in the /POSDW/TLOGF table. They are populated during the transaction checks and

processing.

The only exceptions to this are the MATERIALNUMBER and the MERCHANDISECAT fields at the line item level. These
enhanced fields are stored in the database because they are required by consuming applications.

Analytic Fields

Additional fields were added to the /POSDW/TLOGF for analytic purposes and to improve the performance of the
queries built on top of the new TLOG data model.
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The following table provides information about the analytic fields of the /POSDW/TLOGF:

Table 28: /POSDW/TLOGF Analytic Fields

Field Level Purpose

TRANSCOUNTER Header Fixed value (1) used for counter based
queries

BEGINDATE Header Transaction Date

BEGINTIME Header Transaction Begin Time

CALYEAR Header Transaction Year

CALMONTH Header Transaction Month

CALDAY Header Transaction Day

CALHOUR Header Transaction Hour

CALWEEK Header Transaction Week

TAXINC [tem Amount of included taxes

TAXEXC [tem Amount of excluded taxes

ITEMDISC ltem Amount of item discounts

DISTDISC ltem Amount of distributed discounts from
the header level

DISTTAX [tem Amount of distributed taxes from the
header level

DISTTENDER [tem Amount of distributed tender from the
header level

DISTTAXEXC [tem Amount of distributed excluded taxes
from the header level

DISTVOID [tem Amount of distributed voids from the
header level

TASK_CANCELED ltem Indicator for Canceled Task, distributed
from the header level

RETL_ITEM_CAT ltem Article category

RETL_ITEM_SCAT ltem Article subcategory

RETAILDEBITFLAG Item Flag indicating whether the line item is of
a debit type
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Entity Relationships

In SAP POS Data Management component of SAP Customer Activity Repository, combined semantic keys are

used as primary keys.

To ensure the uniqueness of every record, a child entity inherits its primary key from its parent. It then defines an

additional field that is part of its own primary key.

Parent/child relationships are maintained using these semantic keys. Because a semantic key for a child is a
combination of its parent's primary key and an extra field, the child primary key already contains its parent's

primary key.

Extensibility

The extension mechanism used in SAP Customer Activity Repository is described in the Extensibility and

Extensions section.

Structures

This following table provides information about the structures used in SAP Customer Activity Repository:

Table 29: Structures of SAP POS Data Management Component in SAP Customer Activity Repository

Structure Name

Component

Component Type

Description

/POSDW/HEADER_ANALYT- | TRANSCOUNTER /POSDW/CONSTCOUNTER | Header Analytics data fields
ICS
BEGINDATE /POSDW/BEGINDATE
BEGINTIME /POSDW/BEGINTIME
CALYEAR /POSDW/CALYEAR
CALMONTH /POSDW/CALMONTH
CALDAY /POSDW/CALDAY
CALHOUR /POSDW/CALHOUR
CALWEEK /POSDW/CALWEEK
/POSDW/ITEM_ANALYTICS | TAXINC /POSDW/TAXAMOUNT Header Analytics data fields
ITEMDISC /POSDW/REDUCTIONA-
MOUNT
/POSDW/ITEM_DIST DISTDISC /POSDW/DISTDISC Item Distributed data fields
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Structure Name Component Component Type Description
DISTTAX /POSDW/DISTTAX
DISTTENDER /POSDW/DISTTENDER
/POSDW/ITEM_DISTRIB- INCLUDE /POSDW/RETAILLINEI- [tem line item with distribu-
UTED TEM_FK tion fields
INCLUDE /POSDW/ITEM_DIST
Table Types

The following table types are used in the SAP POS Data Management component of SAP Customer Activity

Repository.

Table 30: Table Types of SAP POS Data Management Component in SAP Customer Activity Repository

Name

/POSDW/TT_TLOGF

Line Type

/POSDW/TLOGF

Description

/POSDW/TLOGF table type

/POSDW/TT_TLOGF_EXT

/POSDW/TLOGF_EXT

/POSDW/TLOGF_EXT table type

/POSDW/TT_TLOGF_X

/POSDW/TLOGF_X

/POSDW/TLOGF_X table type

/POSDW/TT_TLOGF_CONTROL

/POSDW/TLOGF_CONTROL

Table type for control analytics

/POSDW/TT_ITEM_DISTRIBUTED

/POSDW/ITEM_DISTRIBUTED

Table of item distributed fields

/POSDW/TT_CUSTOMIZING_BUFFER

/POSDW/CUSTOMIZING_BUFFER

Customizing buffer table type
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10 The Main SAP Documentation Types

The following is an overview of the most important documentation types that you need in the various phases in
the life cycle of SAP software.

Cross-Phase Documentation

SAPterm is SAP’'s terminology database. It contains SAP-specific vocabulary in over 30 languages, as well as
many glossary entries in English and German.

® Target group:
o Relevant for all target groups
e Current version:

o On SAP Help Portal at http://help.sap.com|j¢ Glossary 3
o Inthe SAP system in transaction STERM

SAP Library is a collection of documentation for SAP software covering functions and processes.

e Target group:
o Consultants
o System administrators
o Project teams for implementations or upgrades
e Current version:
o On SAP Help Portal at http://help.sap.com (also available as documentation DVD)

The security guide describes the settings for a medium security level and offers suggestions for raising security
levels. A collective security guide is available for SAP NetWeaver. This document contains general guidelines and
suggestions. SAP applications have a security guide of their own.

® Target group:
o System administrators
o Technology consultants
o Solution consultants

e Current version:

o On SAP Service Marketplace at http://service.sap.com/securityguide

Implementation

The master guide is the starting point for implementing an SAP solution. It lists the required installable units for
each business or IT scenario. It provides scenario-specific descriptions of preparation, execution, and follow-up of
an implementation. It also provides references to other documents, such as installation guides, the technical
infrastructure guide and SAP Notes.
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e Targetgroup:
o Technology consultants
o Project teams for implementations

e Current version:

o On SAP Service Marketplace at http://service.sap.com/instguides#

The installation guide describes the technical implementation of an installable unit, taking into account the
combinations of operating systems and databases. It does not describe any business-related configuration.

e Targetgroup:
o Technology consultants
o Project teams for implementations
e Current version:
o On SAP Service Marketplace at http://service.sap.com/instguides

Configuration Documentation in SAP Solution Manager — SAP Solution Manager is a life-cycle platform. One of
its main functions is the configuration of business scenarios, business processes, and implementable steps. It
contains Customizing activities, transactions, and so on, as well as documentation.

e Targetgroup:

o Technology consultants

o Solution consultants

o Project teams for implementations
e Current version:

o In SAP Solution Manager

The Implementation Guide (IMG) is a tool for configuring (Customizing) a single SAP system. The Customizing
activities and their documentation are structured from a functional perspective. (In order to configure a whole
system landscape from a process-oriented perspective, SAP Solution Manager, which refers to the relevant
Customizing activities in the individual SAP systems, is used.)
e Targetgroup:
o Solution consultants
o Project teams for implementations or upgrades
e Current version:

o Inthe SAP menu of the SAP system under | Tools » Customizing ¥ IMG 3

Production Operation

The technical operations manual is the starting point for operating a system that runs on SAP NetWeaver, and
precedes the application operations guides of SAP Business Suite. The manual refers users to the tools and
documentation that are needed to carry out various tasks, such as monitoring, backup/restore, master data
maintenance, transports, and tests.

e Target group:
o System administrators
e Current version:
o On SAP Service Marketplace at http://service.sap.com/instguides
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The application operations guide is used for operating an SAP application once all tasks in the technical
operations manual have been completed. It refers users to the tools and documentation that are needed to carry
out the various operations-related tasks.

e Targetgroup:
o System administrators
o Technology consultants
o Solution consultants
e Current version:
o On SAP Service Marketplace at http://service.sap.com/instguidesf

Upgrade

The upgrade master guide is the starting point for upgrading the business scenarios and processes of an SAP
solution. It provides scenario-specific descriptions of preparation, execution, and follow-up of an upgrade. It also
refers to other documents, such as upgrade guides and SAP Notes.

e Target group:
o Technology consultants
o Project teams for upgrades
e Current version:
o On SAP Service Marketplace at http://service.sap.com/instguides#

The upgrade guide describes the technical upgrade of an installable unit, taking into account the combinations of
operating systems and databases. It does not describe any business-related configuration.

e Target group:
o Technology consultants
o Project teams for upgrades
e Current version:
o On SAP Service Marketplace at http://service.sap.com/instguides#

Release notes are documents that contain short descriptions of new features in a particular release or changes to
existing features since the previous release. Release notes about ABAP developments are the technical
prerequisite for generating delta and upgrade Customizing in the Implementation Guide (IMG).

e Target group:
o Consultants
o Project teams for upgrades
e Current version:
o On SAP Service Marketplace at http://service.sap.com/releasenotes#

o Inthe SAP menu of the SAP system under | Help » Release Notes J (only ABAP developments)
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Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system
environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and
completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP
intentionally or by SAP's gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP's current view of accessibility criteria as of the date of publication; it is in no way intended to be a
binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does
not apply in cases of wilful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with "you", or a gender-neutral noun (such as "sales
person" or "working days") is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not
exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not
warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages
caused by the use of related information unless damages have been caused by SAP's gross negligence or willful misconduct. All links are categorized for transparency
(see: http://help.sap.com/disclaimer).
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© 2016 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any
form or for any purpo ithout the express permission of SAP SE
or an SAP affiliate company. The information contained herein may
be changed without prior notice.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software

vendors. National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate compa y
for informational purposes only, without representation or warranty
of any kind, and SAP or its affiliated companies shall not be liable for
errors or omissions with respect to the materials. The only
warranties for SAP or SAP affiliate company products and services
are those that are set forth in the express warranty statements
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as their respective logos are trademarks or registered trademarks
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